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his books, magazine articles, and newspaper reports with award-winning
images. He’s operated his own commercial studio, suffocated in formal dress
while shooting weddings-for-hire, and shot sports for a daily newspaper and
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books listed in the Top 20 of Amazon.com’s Digital Photography Best Seller
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books in Wiley’s Digital Field Guide series, with topics ranging from travel
photography to guidebooks for the Nikon D50, D70s, and D200 cameras.

Busch earned top category honors in the Computer Press Awards the
first two years they were given (for Sorry About The Explosion and Secrets
of MacWrite, MacPaint and MacDraw), and later served as Master of
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Introduction

Fe future of photography is in your hands, and it’s becoming all digital!
Not since the 19th century, when photographers had to be artisan,
craftsperson, artist, chemist, and public relations expert rolled into one, has
so much of the photographic process been entirely in the control of the
person taking the picture. Now you can compose and view the exact picture
you’re going to take by using your camera’s full liquid crystal display (LCD)
screen. Review the picture an instant after pressing the shutter. If your com-
puter is nearby, you can upload it seconds later, view a super-large version
on your display, crop it, enhance it, and then make your own sparkling full-
color print — all within minutes!

When you go digital, you never need to buy film or wait while your photos
are processed in a lab. You decide which images to print and how large to
make them. You can display your digital photographic work framed on your
wall or displayed proudly over your fireplace. You can make wallet-size
photos, send copies to friends in e-mail, or create an online gallery that can
be viewed by relatives and colleagues over the Web.

And if alchemy is in your blood, you can transform the simplest picture into
a digital masterpiece by using an image editor. Correct your photos, delete
your ex-brother-in-law from a family portrait, or transplant the Eiffel Tower
to the seashore.

Digital photography gives you the power to take pictures on a whim or to
create careful professional-quality work that others might be willing to pay
for. The choices are all yours, and digital photography puts all the power in
your hands. All you need is a little information about how to choose and use
your tools and how to put them to work. That’s what you'll find within the
pages of this thick, comprehensive, all-in-one guidebook.

The most exciting aspect of digital photography is how rapidly the technology
is changing to bring you new capabilities and features that you can use to
improve your pictures. Today, digital cameras with 4-megapixel (mp) or less
resolution are difficult to find except in photo-capable cell phones — and
some cell phones offer 10-megapixel or more resolution! Even the leanest
digital camera you're likely to find in stores will have 5-6 megapixels of
resolution. I've tested models in this range that cost less than $150! You'll find
7-megapixel and 9-megapixel cameras for $500 or so, and even 10-megapixel
models are widely available for quite a bit less than $1,000. Digital single-lens
reflex cameras (dSLRs) with interchangeable lenses are available from compa-
nies like Nikon, Canon, Olympus, and Sony if you’re willing to pay top dollar.
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About This Book

Adobe Photoshop has bumped up the image editing ante with lots of new
capabilities of interest to digital photographers, and even inexpensive appli-
cations like Adobe Photoshop Elements have more features than you could
find in the most powerful image editor four or five years ago. Your new hard-
ware and software tools make working with digital images easier while giving
you important new capabilities.

About This Book

This book, now in its third edition and freshly enhanced with full-color
images throughout, has been updated to include all the latest technology
and gadgets available to the digital photographer. It is written for the person
who has a good grasp of using a computer and navigating an operating
system and has at least a cursory knowledge of the operation of a digital
camera. It would help if you had some familiarity with an image editor, such
as Corel Paint Shop Pro, Corel Photo Paint, or Adobe’s Photoshop or
Photoshop Elements. It is intended to be a comprehensive reference book
that you can read cover to cover or reach for when you’re looking for spe-
cific information about a particular task.

Wherever | can, [ sneak in a useful tip or an interesting technique to help you
put digital photography to work for your project needs.

If you have some knowledge of conventional photography, this book will
help you fine-tune your capabilities. If you know very little about photography,
there’s help for you here, too. One large chunk of the book — Book IV — is
devoted to tips on the most popular genres of photography, from close-up
and sports photography to travel photography and shooting for publication.
Check out the helpful section on getting the best composition. If you're puz-
zled over what equipment to buy, look to the sections on choosing cameras,
photo accessories, and related equipment, such as printers and scanners.

There’s a new book in this edition especially for you digital single-lens reflex
(dSLR) users, although you’ll find that another book of mine, Digital SLR
Cameras & Photography For Dummies, goes into more detail on the special
features of these more advanced cameras.

What’s in This Book

This book is broken down into minibooks, each covering a general topic.
Each minibook comprises chapters, each covering a more specific topic
under the general one. Each chapter is then divided into sections, and some
of those sections have subsections. I'm sure you get the picture.
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You can read the book from front to back, or you can dive right into the mini-
book or chapter of your choice. Either way works just fine. Any time a con-
cept is mentioned that isn’t covered in depth in that chapter, you’ll find a
cross-reference to another book and chapter where you’ll find all the details.
If you're looking for something specific, check out either the Table of
Contents or the index.

The Cheat Sheet at the beginning of the book provides helpful information
you’ll use often. Tear it out, tape it to your monitor, and don’t forget to say,
“Thanks.” (You're welcome.)

And finally, you get pictures. Lots of them. Many of these pictures illustrate
good photo techniques as well as traps to avoid. You'll find examples of the
kinds of pictures you can take right away and maybe a few that you'll want
to strive to equal or exceed.

This book contains eight minibooks. The following sections offer a quick syn-
opsis of what each book contains.

Book I: Digital Photography Overview

This section is your digital photography short course, providing all the infor-
mation on a variety of topics that you really need to know to get started. Each
of the six chapters is an overview of topics covered in depth later in the book.
You'll find the essentials of good digital photography, equipment basics, and
how to acquire digital pictures. Buzz through the quickie introduction into
some of the ways you can edit or restore a photo electronically and take a look
at how you can store and organize your digital photos. Then, if you're inter-
ested in what’s involved in selecting a printer or scanner, you’ll find all the
basic information summarized for you in an easy-to-understand way.

Book I1: Building Your Digital Photography Studio

This book helps you choose the right camera, whether it’s your first digital
camera or the one you're dreaming about as a replacement for your current
model. You'll read all the facts on resolution, lens settings, storage, and acces-
sories. One chapter shows you the requirements for setting up a PC for digital
photography. The good news is that you probably already have everything
you need in your computer. I'll give you some advice on recommended
upgrades that can make your system work even better with digital images.

You'll also discover your options for getting pictures from your camera into
your digital darkroom. And, if you want to get the most from your pictures,
you’ll want to read up on how to add a scanner and printer, too.
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What’s in This Book

Book 111: Using Digital SLRs

This book provides a concise overview of the tools and capabilities you’ll
find in the latest digital SLR cameras. You find out why these cameras can do
things that their non-SLR counterparts cannot and how to use those features
to improve your photography.

Book 1V: Taking Great Pictures

This is the meat of the book for veteran and aspiring photographers alike.
Each of the six chapters is devoted to a different kind of photography. You'll
see the basic rules for composing great photos — and when to break them.
You'll discover the secrets of close-up photography and how to make pleas-
ing portraits of individuals and groups.

Whether shooting for publication is part of your job description or just a
goal, you'll find tips on how to take publishable photos and how to market
them. [ also include chapters on sports and action photography as well tips
on travel photography.

Book U: Basics of Image Editing

This book is your introduction to image editing, providing general tips on what
you can — and can’t — do with popular image editors such as Paint Shop

Pro, Corel PhotoPaint, Photolmpact, or Adobe Photoshop and Photoshop
Elements. You'll see the capabilities of these programs, discovering the full
range of tools at your disposal.

The book winds up with a chapter that compares and contrasts the most
popular image editors so you can choose which image editing program you
really need (or whether you might even benefit from owning two!).

Book UI: Editing with Photoshop
and Photoshop Elements

This book goes into a little more detail on the use of the two most popular
image editing programs: Adobe Photoshop (favored by professionals) and
Adobe Photoshop Elements (an inexpensive younger sibling that has lots of
power but is still easy to use). You discover the power of making selections,
brush away problems in your digital photos, correct your colors, and apply
special effects with filters.

Although this book is not a complete guide to Photoshop, you'll find lots of
good information you can use right away to try out your digital photo editing
muscles. (For tons of in-depth coverage, read Photoshop CS2 All-in-One Desk
Reference For Dummies, by Barbara Obermeier [Wiley].)
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Book VII: Restoring Old Photos

Continue your study of Photoshop and Photoshop Elements with this book,
which shows you how to restore old photos and make some common repairs
to your digital images. Read chapters on scanning in print images, tips for
working with slides and negatives, and some common fixes for vintage
photos.

Book VIII: Printing and Sharing Your Digital Images

Your digital photos are going to be so good that you won’t be able to keep
them to yourself. This book provides more information on printing your
photos and shows you ways to share your pictures over the Internet. You'll
become more comfortable with your printer’s capabilities, discovering all
the things that you can do with photos online, whether it’s showcasing your
pictures among your friends and colleagues or making photo greeting cards,
T-shirts, or other gift items.

Conventions Used in This Book

Digital photography knows no operating system limits. All digital cameras and
many software applications work equally well on a PC and a Macintosh. To
that end, this book is cross-platform. Understandably, some differences do
crop up, particularly in the chapters that deal with image editing. In this book,
Windows commands are given first, followed by Mac commands, like this:

Press Enter (or Return on the Mac) to begin a new line.

Occasionally, text will be specific to one platform or another. Commands
listed often involve using the keyboard along with the mouse — for example,
“Press Shift while dragging with the Rectangular Marquee tool to create a
square,” or “Alt+click (Option+click) the eyeball to redisplay all layers.”

When you see a command arrow (=) in the text, it indicates that you should
select a command from the menu bar. For example, “Choose Edit=>Define
Custom Shape” means to click the Edit menu and then choose the Define
Custom Shape option.

Although this book was written based on the latest digital cameras and the
newest software (such as Print Shop Pro and Photoshop), if you're still
bouncing around with earlier versions, you can still glean valuable info. You
might just have to poke around a little more to find a tool or option that has
moved — and of course, the topics covering new features won’t be applica-
ble. But hey, seeing the cool new features might just be the impetus you need
to go out and upgrade!
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Icons Used in This Book

While perusing this book, you’ll notice some icons in the margins beckoning
you for your attention. Don’t ignore them; embrace them! These icons point
out fun, useful, and memorable tidbits about digital photography, plus facts
you’d be unwise to ignore.

P This icon indicates information that will make your digital photography
experience easier. It also gives you an icebreaker at your next cocktail party.
Whipping out, “Did you know that many digital cameras can focus down to
within an inch of an object?” is bound to make you the center of conversation.

é‘,“‘ This icon is a reminder of things that [ want to gently re-emphasize. Or |
might be pointing out things that I want you to take note of in your future
digital photography excursions.

The little bomb icon is a red flag. Heed these warnings, or else your camera
or image editor might show its ugly side.

This icon points out info you don’t necessarily need to know. If you're
interested in getting more technical, however, you’ll find such information
interesting.

Where to Go from Here

If you want your voice to be heard, you can contact the publisher of the
For Dummies books by visiting www . dummies . com, by sending an e-mail to
customer@wiley.com, or by sending snail mail to Wiley Publishing, Inc.,
10475 Crosspoint Boulevard, Indianapolis, IN 46256.

And, of course, the very next place to go is to the section of this book that
covers your favorite topic. Go ahead and dive right in.
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If you're shifting your digital photographic pur-
suits into high gear and want to hit the ground
running, this minibook is your fast track to pixel
proficiency. You can consider the six chapters

in this overview both a quickie course in digital
photography concepts as well as a preview of what
you can discover in the rest of the book. All the
basics are here, so you can begin taking, sharing,
and printing great photos right away. When you
want to find out more, you can follow the cross
references in this book to discover the in-depth
coverage you'll find in the other sections.

This minibook outlines the essentials of good
photography and shows you how to decide which
digital equipment will do the best job for you.
You'll discover the best ways to acquire digital
pictures — whether you choose to use a camera
or scanner — and find out the fundamentals of
editing and restoring photos with image editors
like Photoshop, Photoshop Elements, and Paint
Shop Pro. If you want to share and preserve
your digital images, you’ll find tips on managing,
archiving, and printing your photos, as well as
discover the best ways to post them online for
others to enjoy.




Chapter 1: The Essentials of Good
Digital Photography

In This Chapter

1 Choosing equipment
1~ Making great digital photos
~ Converting other photos to digital format

1 Making hard-copy prints

]n 1888, George Eastman began promoting the first hand-held Kodak
camera with the slogan, “You press the button, we do the rest.” His idea
was to make the film camera as convenient as the pencil. However, the film
king’s dream didn’t really come true until the invention of the digital
camera.

Certainly, conventional photography has long been as
simple as pressing a button, but the “we do the rest”
part — taking the film to a photo lab, deciding what
size and kind of prints to make, and then waiting for
the results — is a lot less convenient than using a
pencil.

Digital photography has finally put the entire
process of making pictures in the hands of the
person holding the camera. You press the button,
and you can do as much of the rest yourself as
you’re comfortable with. If all you want to do is point
and shoot, you can do that. If you want to get more
involved in the picture-taking and picture-making process,
digital photography gives you the tools for that, too.

You compose the picture through the viewfinder (as always), but now, you
can preview the exact photograph that you’re going to take on a bright LCD
(liquid crystal display) screen on the back of your camera. After snapping a
shot, you can instantly review the photos you've taken and erase the bad
pictures on the spot or “mark” the ones you want to print.
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You don’t need to remember to stop and buy film. Your digital film is almost
infinitely reusable. You don’t have to drop off your digital film for finishing:
It’s “processed” instantly and ready for viewing or printing using your own
inexpensive color printer. No more sifting through stacks of prints of mar-
ginal images. You decide which images to print and whether to make them
4 x 6 inches or 5 x 7 inches or some other size. You can print them at home
inexpensively or take a tiny digital memory card to a nearby retailer and
have even more inexpensive prints made for you in minutes by an in-store
digital print lab.

On the other hand, if you want to have full control over your photos, digital
photography gives you that, too, to a degree that has never before been
possible. Perhaps your images aren’t exactly right or could benefit from a
little cropping or other improvements. You can fix bad color, remove your
ex-brother-in-law from a family photo, or adjust the borders of an image to
focus on the most interesting subject matter. All you need is an image editor,
such as Photoshop or Photoshop Elements.

This chapter provides an overview of the sorts of things you find out how to
do in this book. I cover each topic in more detail later on in a minibook and
chapter of its own. I'll keep the repetition to a minimum; the chapters in
Book I are intended to offer an introduction to topics that are explored more
deeply elsewhere in the book.

Knowing What Equipment Vou Need

I realize that you might not be curled up with this book in one hand and a
digital camera in the other. You might already have a digital camera, and you
purchased this book to find out exactly what you can do with it. You’ll find
the tips and information you need throughout this volume.

However, I'm guessing that some of you haven’t taken the plunge yet. You're
ready to stop being a hold-out and want to join the digital camera revolution.
So you bought this book to find out more about digital photography before
spending your hard-earned money on the equipment you need. Good plan!

After all, there are so many choices available that it’s easy to buy a camera
that’s not quite right for the kind of pictures you want to take. All digital
cameras do a good job with general picture-taking for family activities,
travel, informal portraits, and other kinds of shots. But some are better than
others for taking close-up photos, sports action pictures, or photos indoors
where a wide view is needed.

So, you'd like some of your questions answered before you buy: Can a camera
I can afford do the things [ need to do? Can a computer fumble-fingers like me
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really do digital photography? What’s the best camera to buy? Will [ be able
to expand my camera’s capabilities if I find | need more advanced features?

Or, perhaps you are a digital camera veteran who is already thinking of
upgrading. You, too, need some advice about equipment, which you can find
in this book.

Choosing a digital camera that’s right for you can be tricky because a lot
more goes into your selection than simply the specifications. Two cameras
with identical specs can perform quite differently. One may exceed your
expectations, while the other one frustrates the heck out of you. I explore
some of the subtleties of camera selection in Book I, Chapter 2.

The digital camera world has changed dramatically since [ wrote the first
edition of this book. | warned readers against trying to do serious photo-
graphy with cheap Web cams or low-end 1-megapixel cameras. Today, some
camera phones have a lot more resolution than that, and even the lowest
priced digital cameras (in the $100-$200 range), have 4 megapixels (millions of
pixels of information). They are more likely to have at least 5 to 6 megapixels
of resolution. They feature automatic exposure, a color LCD viewing screen for
previewing or reviewing your photos, and removable storage, so you can take
out your digital film card when it’s full and replace it with a new one to keep
shooting. Most have a 3X zoom lens, so you can magnify an image without
moving forward, which is invaluable when you want to take pictures of differ-
ent subjects from one spot.

Those minimum specs give you everything you need to take great photos.
After all, the photographer, not the camera, produces the best images. [ once
wrote an article for a photo magazine in which I presented photos of the
same subjects, side-by-side, taken with an inexpensive point-and-shoot film
camera and a full-blown professional system that cost 100 times as much.
After both sets of photos had been subjected to the vagaries of halftone
reproduction, it was difficult to tell them apart.

Spending a lot on a digital camera buys you a few new capabilities, like
better zooms, enhanced resolution, or a more sophisticated built-in flash. If
you have a full-featured model, you can find lots of information in this book
on how to get the most from your camera’s capabilities. But this book also
contains workarounds for those who own more modest equipment.

You can find digital cameras suitable for the most exotic of photographic
pursuits, such as the underwater set-up shown in Figure 1-1. It’s a waterproof
case for a Canon PowerShot digital camera. It provides full access to all your
camera’s controls while letting you photograph those colorful coral reefs in
Tahiti at depths of up to 100 feet!

Book |
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Minimum and Maximum Specs

Figure 1-1: This waterproof case can take your digital photography
to new depths!

Minimum and Maximum Specs

For most of this book, [ assume you have a digital camera with at least

4 megapixels of resolution. (If you don’t understand resolution right now, see
Book I, Chapter 2, for an explanation.) Such cameras are becoming harder to
find; it’s likely that 5 and 6 megapixels will become the minimum resolution
for new cameras introduced during the lifespan of this book.

A camera with a 4-megapixel sensor corresponds to about 2300 x 1700 pixels,
which is enough detail to give you decent 6-x-8-inch prints or larger at 200 dpi
printer resolution. A 4-megapixel camera also can capture enough information
to allow some cropping, especially if you plan to use the image on a Web page,
where high resolution isn’t necessary.

However, if you happen to have an older camera with less resolution, you
can still do plenty of things. You can prepare images for dynamite Web pages
and make sparkling 4-x-5-inch prints. One of my favorite cameras is an
ancient 3.3 megapixel Nikon CoolPix 995 that is excellent for close-up
photos, and I use it from time to time to take pictures for eBay auctions.

Cameras with up to 6 megapixels or more of resolution have dipped down
into the inexpensive camera range (under $200), and if you have a little
more to spend, you can find point-and-shoot cameras with 10 megapixels of
resolution for only a few hundred dollars more. Digital single lens reflex
(dSLR) cameras, which boast faster operation and interchangeable lenses,
offer around 6 to 8 megapixels of detail in the sub-$1,000 price range, and
10 to 12 megapixels (and more) if you're willing to pay at least $1,500 for
your camera. (You can read more about dSLRs in Book III.)
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Extensive coverage of digital SLR cameras is new to this latest edition, but
very little in this book actually requires a dSLR to achieve. Those of you with
these high-end cameras should still find lots to like in this book; one of my
goals has been to present pro-level techniques in ways that can help anyone.
If you have a digital SLR like the one shown in Figure 1-2, you'll find these
techniques especially useful. If you want to find out even more about these
cameras, [ recommend my book, Digital SLR Cameras & Photography For
Dummies, from Wiley Publishing.

If you own a more sophisticated camera, whether it’s a digital SLR or an
advanced non-SLR camera, there are lots of additional capabilities at your
fingertips. You can make tack-sharp 8-x-10-inch prints (and even larger prints
if your printer supports them or if you take your digital files to your retailer).
You can crop out the center of an image and still have sharpness to spare.
Your camera will have loads of automated features, such as automatic brack-
eting (taking several exposures at different settings to make sure one is
ideal) or a very long zoom lens (to reach way out and capture distant
objects). Your camera may be able to take time-lapse photos and stitch
images together to create panoramas.

Although [ seem to focus on the number of pixels a camera has, other con-
siderations, such as the range of the zoom lens, may also be important to
you. Even the least expensive cameras may have a 2:1 to 3:1 zoom, which
can magnify an image 2X and 3X (respectively). Better cameras have 4:1 or
longer zooms, up to 12:1 or more. Digital SLRs offer the best zoom capabili-
ties of all: You can remove one lens and swap it for another with a longer
range or with wider or longer perspectives. Your camera probably has
macro, or close-up, capability, which lets you grab images from inches away
from your subject. Book IV, Chapter 2 is devoted to close-up techniques.

Most of the other components (such as the amount and type of memory
storage, manual/automatic exposure and focusing options, built-in flash
capability, and so on) can vary widely. You can find discussions of these in
Book I, Chapter 2.

One thing I avoid in this book is mentioning the names of specific camera
models, except as a matter of interest from time to time. It’s more likely that
I'll mention 10- or 8 or 5-megapixel models in a generic sense. You won't find
extensive discussions in this book about the relative merits of the latest Nikon
or Canon cameras or other references that will be hopelessly outdated in a
few months. (Those of you reading this in 2008 with your $500 12-megapixel
cameras should refrain from laughing as you encounter some of my quaint
advice.)

Book |
Chapter 1
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Taking Great Digital Shots

Figure 1-2: Digital SLR cameras allow you to remove one lens and replace it with another
one with different capabilities.

Taking Great Digital Shots

\\3

So, when you have a camera in hand, what do you need to know to take great
digital photos? In this section, I discuss the knowledge that needs to reside
in your brain (or be otherwise available) to take great pictures.

Understand how your camera works

No digital photography book can tell you how to turn on your camera, how
to adjust the auto-exposure settings, or how to use your model’s self-timer to
take a picture with you in it (although Wiley Publishing’s Digital Field Guide
series does offer editions for specific camera models). Those are things

best found in your camera’s instruction manual. Read it. [ promise that the
information you seek is in there; it may just be hard to find. The instructions
for one of my own digital cameras were so cryptic that I found myself creat-
ing a cheat sheet with lists of steps, such as, “To turn off the auto-sharpening
feature, press the Menu button, then. . ..”

Some of the techniques in this book call for using a specific exposure mode
or lens setting. | may ask you to switch to your camera’s close-up mode

to take photos a few inches from your subject. You may need to use your
camera’s built-in flash. Learn how to do these now so that you can add some
simple but effective tools to your shooting repertoire.
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Know some photography fundamentals

Certainly, you can point your camera and snap off a picture that may turn out
great. Some prize-winning shots were taken in an instant as a fast-breaking
news event unfolded without warning. Amateur photographers took more
than a few of those photos, such as the famous Pulitzer Prize winner of a
woman falling from a burning hotel, captured by a 26-year-old Georgia Tech
student. However, whatever part instinct and luck take in the production of
great pictures, a little knowledge can be much more important.

4 If you know a little about composition, you can nudge your images into a
more pleasing arrangement. (See Book IV, Chapter 1, for a full course in
photographic composition.)

4 Understanding how focus can make parts of your image sharp or blurry
gives you the freedom to use focus selectively to isolate or emphasize
subjects (Book IV, Chapter 2).

4+ Some background in how shutter speeds can freeze action can improve
your sports photography (Book IV, Chapter 5).

4+ And you don’t need to become an expert in lighting effects, but under-
standing how light works can improve your people pictures (Book IV,
Chapter 3).

Find out how to use an image editor

In digital photography, the pseudo-snap of an electronic shutter is only the
beginning. You can do lots of things after the shot to improve your photo —
or transform it into an entirely new one. Simple image editors enable you to
crop pictures, fix bad color, or remove defects, such as those glaring red
eyes found in many flash photos. However, you can find even more creative
freedom in more-advanced image editors that let you do anything from
eliminating trees that appear to grow out of your subject’s head to bringing
seriously damaged photos back to life. If you want to polish your reputation
as an all-around digital photographer, plan on developing at least a modicum
of skill with a decent image editing program. You'll find general information
on a broad range of image editors in Book V, and specifics on Adobe
Photoshop and Photoshop Elements in Book VI.

Master a scanner

Digital photographers don’t have to own a scanner, but you don’t have to
own a camera bag or an extra digital film card, either. Like other digital
accessories, a scanner provides you with some supplemental techniques
that let your scanner complement or substitute for your digital camera. For
example, if you have a large stock of images that originated on film and now

Book |
Chapter 1
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exist only as prints or negatives, a scanner can help you convert them to
digital format. A scanner also can be used for producing close-up images of
relatively flat three-dimensional objects, such as coins. A scanner can grab
pictures of very small objects (less than 1 x 1 inch) that are difficult to cap-
ture with a digital camera.

GMBER The exact kind of scanner you have isn’t important, as long as it’s a flatbed
model, like the one shown in Figure 1-3. I explain the differences between the
major types of flatbeds and how their capabilities diverge (that is, some
scanners can be used to scan three-dimensional objects, whereas others
can’t) in Book I, Chapter 4.

Figure 1-3: This scanner’s novel design lets you view the photo through the glass while it is
being scanned.

Making Any Photo Digital

In this book, you can also find out how to transform any photo you happen
to have into a digital image. Scanners are one way to do this: Slap an existing
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photo down on the scanning bed and scan it into your image editor, and you
have a digital image that’s the equal of anything you might capture with your
digital camera — except it’s likely to have dust spots!

Or, drop off your film at your local photo lab and request a Photo CD or
Picture CD along with (or instead of) your prints. These CDs can be pro-
duced from slide film, too, or even from stacks of existing prints. What you
receive for your money is a scan of your images, perfect for manipulating in
your image editor and printing on your own color printer. You don’t even
need to own a scanner: Your photo lab does all the work for you.

Another option is using a local or mail-order service that processes your film
and puts the finished images on the Internet. You can download your photos
to your computer or make them available for viewing by family, friends, and
colleagues on a Web page. What could be easier? You can find more informa-
tion on this topic in Book VIII, Chapter 2.

Printing Your Final Pictures

The final piece of the digital photography puzzle is the hard-copy print. You
may create photos electronically, view them on your computer, post them on
your Web site, and send them to others as e-mail, but nothing beats having a
stack of prints to pass around or an enlargement to hang over the fireplace.

So, in Book I, Chapter 6, you can find basic information on making prints, and
you can find more advanced advice in Book VIII. The good news is that the
equipment you need is inexpensive and easy to use. A photo-quality inkjet
printer can set you back $100 or so. It probably plugs directly into a USB
port on your computer and requires little or no setup. Making the prints can
be a point-and-click operation. A variety of printers can do the job for you.
The one shown in Figure 1-4 can produce prints directly from your digital
camera or storage media, with no computer required at all!

The bad news, if it can be called that, is that the cost of materials can seem a
little high. You can pay $1.00 or more just for the paper and ink for a single
8-x-10-inch print. However, | show you some money-saving tips in Book VIII,
Chapter 1. The best news is that you don’t make a print of every single photo
you take. You can view your prints on your computer display and make hard
copies of only the very best. From that angle, making your own prints isn’t
expensive at all. You’re printing only the pictures you want, and in the long
run, probably paying a lot less overall than you used to spend on those
prints that wound up in a shoebox.

Book |
Chapter 1
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Figure 1-4: Plug a memory card into the slot on this printer, choose an image on the built-in
LCD, and you can make a print without using a computer.



Chapter 2: Basics of Equipment

In This Chapter

1~ Choosing the best camera
1~ Looking at resolution
1 Examining camera categories

1+~ Checking out basic camera features

C hoosing a digital camera isn’t a once-in-a-lifetime thing any more than
buying a car, choosing a computer system, or purchasing a television
would be. Your goal should be to select the digital camera that can do the
job you want today and for the foreseeable future but not for the rest of
your life. Odds are, you’ll be making the decision all over again two or three
years down the road, when prices have dropped even further and new fea-
tures are available.

So, you want to choose wisely now, while planning to
make future upgrades. In that sense, purchasing a
digital camera is more like buying a television than
a computer system. Most computers can be easily
upgraded to add features or improve performance.
You can increase the amount of memory, substi-
tute a DVD burner for an older CD-ROM drive, and
perhaps even double or triple the speed with a
NEew Processor.

Digital cameras aren’t easily overhauled. You're
pretty much stuck with the sensor and storage
system built into the camera on the day you
purchased it. If you don’t have a digital SLR with
interchangeable lenses, you're more or less married to the

lens that comes attached to your camera. You can certainly

enhance your camera with add-ons, such as lens attachments, additional
removable storage, or a better external electronic flash unit. But, essentially,
no matter how much digital cameras improve over the next few years, yours
will stay the same. Just as you wouldn’t purchase a 45-inch conventional
projection TV now if you're going to need a 42-inch HDTV set next year, you
want a digital camera that’s ready for everything you plan to throw at it.



20 Deciding What You Need

This chapter is an overview of what to look for when choosing the digital
camera that’s best for you, whether you're a well-heeled amateur who
changes cameras as often as many of us change clothes, or you're a frugal
buyer who wants a camera that will do the job for two or three years. You
find out the basics of the features that you need to evaluate before you lay
down your cash. In Book II, I go into more detail as you build your digital
studio, starting with a detailed look at cameras and features in Book II,
Chapter 1.

Deciding What You Need

What's the best car on the market? It’s hard to say without knowing your driv-
ing plans, isn’t it? Will you be making a 40-mile commute on crowded freeways
every day? You might find that a 40-miles-per-gallon econobox suits your
needs. Do you have six kids to transport? Plan on driving off-road? Need to
impress the country club set? Will you be running in road rallies during the
weekends? You can see why the automotive world has so many options.

“&N\BER The same holds true in the digital camera realm. Some kinds of cameras do

& some kinds of things better or more easily. Although you can use workarounds
to get great sports photos or close-ups with cameras that aren’t particularly
suited to those situations, you're better off carefully defining your expecta-
tions before you purchase a camera.

Unfortunately, price isn’t the best indicator. If you want to take lots of different
kinds of pictures, you can’t just buy the most expensive camera and figure
that it has every feature you can possibly need. It’s more likely that you’ll end
up with a camera that’s so complicated you’ll spend more time trying to figure
out how to access a feature than actually taking the photo. I've used digital
cameras that forced me to access a menu, press several buttons, and then
turn a dial just to be able to manually focus.

In the following sections, I discuss some of the things you need to consider
before you begin to narrow your choice to a particular category or brand of
digital camera.

How much resolution do you need?

Digital cameras are often categorized simply by the amount of detail they
can capture, measured by the number of pixels available in the sensor,
regardless of their other features. While the resolution of the camera may be
3000 x 2000 pixels (or some other figure), they’re advertised only by the
total number of pixels they can grab. Thus, they’re classified as 5-megapixel,
6-megapixel, or 9-megapixel cameras, as if that resolution figure is the only
measure of the camera’s value. | can almost visualize digital cameras on
shelves with unit pricing stickers like you find at a supermarket. Hmmm . . .
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one camera offers 8000 pixels per $1.00, whereas this other one gives you Book
12,000 pixels per $1.00. The second one is clearly a better deal! Chapter 2

‘X&N\BEB In practice, the resolution you require depends a lot on what you plan to do
& with the photos you take. Do you plan on making excellent 8-x-10-inch or
larger prints? If so, you need a camera with a minimum of 5 to 6 megapixels.
Is it likely you'll crop a small section out of the center of an image and make
a 5-x-7-inch print out of that? You’ll need one of those high-resolution cam-
eras, too. You may be able to see the difference between the left photo in
Figure 2-1, taken with a 6-megapixel camera, and the version to the right,
taken seconds later at a 3.3 megapixel resolution. (Both images have been
cropped so you can see fine detail in the brickwork of the structure.). But,
given the loss of detail that occurs any time a photo is reproduced for the
printed page, you might not see much difference. In that case, wouldn’t the
6-megapixel camera be overkill?

juawdinb3 jo soiseg

Figure 2-1: A 6-megapixel image (left) provides more detail than the 3.3 megapixel version
(right) — or does it?

Do most of the photos you take end up in digital presentations viewed on your
computer screen? Are you creating newsletters or other desktop publications?
Will you rarely make prints larger than 4 x 6 inches? A camera with 5 to 6
megapixels will probably do the job for you. With the money you would have
spent on pixels, you can invest in a camera with a better zoom lens or more
digital film (so that you can take more vacation pictures).
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Perhaps you’ll be taking pictures of things you plan to sell on eBay. Figure 2-2
shows a photo I took for an eBay auction when I began unloading my
beloved older film cameras so I could buy new digital equipment. This photo
was resized to 600 pixels wide so that people who viewed the auction page
could download the photo quickly, so virtually any digital camera, from 2
megapixels on up, would have done the job. Or, you might be setting up a
Web page of your own with lots of individual photos. A camera with as few
as 4 to 5 megapixels might have plenty of resolution for that application. You
can find tiny digital cameras in this range that slip in a pocket and are always
available for a quick snapshot. There really are times when less is more.

Figure 2-2: Photos used in eBay auctions, such as this one of a classic film camera, rarely
need to be wider than 600 pixels, so the lowest resolution digital cameras can do the job.

As you decide the amount of resolution you need, remember that digital
cameras are downwardly compatible. A higher resolution camera has
shooting modes at lower resolutions, so your 8-megapixel camera can take
4-megapixel photos if you need them, which saves space on your digital film
and hard drive when the extra resolution isn’t required. If 90 percent of
your photos require only 4 megapixels of resolution, but a solid 10 percent
could benefit from a bit more pixel-grabbing capability, seriously consider
getting a higher-res model. I look at resolution in more depth in Book II,
Chapter 1.
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Do you plan to manipulate your photos?

Many digital photographers don’t want to mess with image editing programs.
All they want to do is take pictures and either make prints or view them in
digital albums on-screen. They see the need to spend extra time with an
image as a drawback and find tasks such as cropping or correcting colors to
be a needless waste of time. Such snap-shooters fall into two broad cate-
gories. Many are amateurs with little interest in photography itself; their
interest is in the pictures that capture memories of vacations or document
their little ones as they grow up. Others are business professionals who use
photographs as a means to an end and who want the process to be as fast
and as simple as possible. If you were a real estate agent preparing an online
database of homes for sale, would you want to spend a lot of time editing
hundreds of photos of your listings?

On the other hand, others take great joy from the ability to edit their photos,
using image manipulation as a creative outlet or, at the very least, a means to
perfect their photographic vision as they tweak the image to look exactly as
they planned.

If you belong in the latter camp, you’ll want a camera with lots of features and
lots of options so that you can get sharp images worthy of your image-editing
efforts. But if all you want are pictures, consider a basic point-and-shoot digital
camera.

Are you a photo hobbyist?

If photography was in your life long before you considered buying a digital
camera, you'll want all the manual features you can get, a powerful zoom lens
to give you a variety of perspectives, and compatibility with as many add-on
gadgets as possible. In fact, you probably want a digital SLR. Dedicated photo
hobbyists talk about the importance of composition, darkroom skills, and the
photographer’s eye. But [ haven’t met one yet who didn’t think that a bit of
technology, properly applied, couldn’t make a good photo even better.

Photo hobbyists tend to spend a lot on their pastime and understand and
value all those features that others seldom use. If you're an avid amateur
photographer, don’t try to scrimp when the time comes to buy your digital
camera. You'll regret it later.

How often do you plan to upgrade?

If you don’t intend to replace your digital camera for a long time, consider
spending a little more now on a camera that will avoid the shadow of
obsolescence a little longer. On the other hand, if you know you’ll buy a
new camera next year, go ahead and buy one that suits your needs today.
Tomorrow will take care of itself.
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Defining Camera Categories

Believe it or not, you can purchase a digital camera for the long term if you
opt for more than a basic model. For example, you can use a 6- to 7-megapixel
digital camera with a zoom lens and a standard removable storage system,
such as CompactFlash, for most applications for a long time to come. Such a
camera has enough resolution for good-looking 5-x-7-inch and 8-x-10-inch
photos and is versatile enough to take a broad range of pictures. Unless your
needs change drastically, a good digital camera in that range can serve you
well for two or more years.

If you find yourself yearning to take different kinds of photos and are con-
stantly upgrading your expectations, however, you’ll probably want to
upgrade cameras more frequently. Digital cameras are adding features at
reduced prices at an amazing rate. When [ wrote my first digital photography
book in 1995, a 6-megapixel SLR digital camera could cost as much as a new
car. By the turn of the century, 6-megapixel dSLRs were available for $5,000;
today, they cost $800 or less.

If you can afford it, you might want to upgrade every year or two. Even if you
can do that, it’s wise to take your upgrade plans into account when buying
today. You’ll want to use the accessories you buy now with your new
camera. Or, if your pocketbook has restrictions, you might want to scale
back your expectations today so that you can afford to dump your current
camera when you upgrade.

Defining Camera Categories

Digital cameras fall into several overlapping categories, which are usually
defined by the number of pixels they can capture plus some other features,
such as lens type, availability of manual controls, add-on accessories, and
other features. Specifications that define a category change over time. Point-
and-shoot cameras once had 640 x 480 to 1024 x 768 resolution (less than a
megapixel). Today, even the most basic cameras have 4 megapixels or more of
resolution. However, the categories themselves have remained fairly constant
in terms of types of snap-shooters or photographers they attract.

Web cams/phone cams

This book more or less ignores Web cams and cell phone cameras. They're
not toys, but they’re not digital cameras within the scope of this book.

Web cams are low-cost (often less than $30) TV cameras that can supply
low-resolution (640-x-480 or 320-x-200/240-pixel), full-motion images that can
be transmitted over the Internet, put on Web pages, or attached to e-mails.
Most can also capture low-resolution still images.

These cameras frequently have no removable storage, no controls, and
lenses that don’t zoom and may not even have a facility for changing focus.
Only a few years ago, they made a good first camera for kids or a spare
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digital camera, but today that function is more = Book |
likely to be found in the cell phones that virtu-
ally every person in the country seems to carry
constantly. | have one in my Nokia cell phone,
shown in Figure 2-3, and I find it useful for
sending photos to family members along with a
text message on the order of “Is this what you
wanted me to pick up on the way home?” They
can also be handy for note-taking (say, to docu-
ment the various steps of a science experiment).
However, most Web and phone cams aren’t flexi-
ble enough for serious digital photography. That
may change during the life of this book, how-
ever; at least one vendor has introduced a cell
phone camera with 10 megapixels of resolution.
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Point-and-shoot models

Point-and-shoot digital cameras cost about $200

and can do anything a simple film camera can do. ~ Figure 2-3: Web cams and
Most have 4- to 6-megapixel resolution, a built-in phone cams are fun, but they
flash, some sort of removable storage (although aren't ready for prime time.
the memory card is probably an optional pur-

chase), and a 3:1 zoom that provides a little magnification. Expect automatic
exposure and no manual controls. Figure 2-4 shows an innovative two-lens
point-and-shoot model.

Figure 2-4: A typical point-and-shoot camera will have basic features, including a 3X zoom
lens — and a few have two lenses, like this model.
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Intermediate models

Intermediate digital cameras are priced in the $200 to $500 range, and
cameras in this category are the most widely used. As such, they have
the best compromise of features to suit most consumer needs.

Look for 6- to 10-megapixel resolution; a 5:1 zoom lens; and at least a few
special options, such as different exposure modes, close-up focusing, or
manual controls. Figure 2-5 shows a selection of intermediate-level digital
cameras.

Figure 2-5: Intermediate digital cameras offer more features, such as longer zoom lenses or
ultra-compact size.

Advanced consumer models

In the $500 to $600 price range, you can find digital cameras aimed at those
who want some special features, extra resolution, or a longer zoom lens. Many
of these, like the one shown in Figure 2-6, provide two LCD viewfinders: the
traditional back panel display and a second, “electronic viewfinder” (or EVF)
inside the camera that provides a dimmer, but still SLR-like view. These are

6- to 10-megapixel models with 6:1 to 12:1 zooms (or better) and plenty of add-
on accessories, such as wide-angle and telephoto attachments, filters, external
flash units, and more.

You can also find lots of optional exposure modes, customizable settings, and
other (potentially confusing) features. Advanced consumer cameras usually
require a session or two with the instruction manual to master all their capa-
bilities, but they have few limitations.
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Figure 2-6: Advanced consumer models may offer both a back-panel
LCD and a second EVF display seen through a viewing window.

Prosumer dSLR models

Prosumer digital SLR cameras (see Figure 2-7) are the models that photo buffs
and even a few professional photographers favor. The avid photographer
doesn’t countenance much in the way of compromises and is willing to spend
the $600 to $1,800 sticker price for these cameras in order to get the advanced
features. Pros find them useful as backup cameras, even if most aren’t quite
rugged enough to take the beating that professional equipment is subjected to.

Prosumer dSLR cameras feature interchangeable lenses and are prized for
their ultra-fast response. Such cameras have virtually no shutter lag (the
delay between when you press the shutter release all the way and when the
picture is actually taken) and can crank out 3 to 5 pictures per second for
action sequence photography. They can be purchased just as a camera body
alone (in case you already own compatible lenses, perhaps for an older film
camera) or in a kit that includes an inexpensive but serviceable zoom in the
18mm-55mm or 18mm-70mm range.

Expect a minimum of 6 to 10 million pixels to shoot with, plus a lot of extra
weight to lug around compared to point-and-shoot cameras. All controls and
features of a prosumer digital SLR match or beat those found on conventional
film cameras. You get automatic and manual focus, multiple automated
exposure modes, plus manual shutter speed and lens opening settings if you
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want them. The key differences between high-priced prosumer digital SLR
cameras and professional digital SLR cameras is resolution (pro models have
12 to 16 megapixels or more), speed (pro cameras can usually snap off digital
pictures at a 5 to 8 pictures-per-second clip; prosumer models may be limited
to 3 pictures per second), and ruggedness.

Figure 2-7: Prosumer digital SLR cameras offer interchangeable lenses and other advanced
features.

Professional models

Pro digital cameras still cost $3,000 and up and have both the pedigree and
features to match. These high-end models are the equal of their film camera
counterparts in every way, and, indeed, some vendors are already phasing
out their film camera production. If you can’t do it with one of these, it can’t
be done.

You'll find 12- to 22-megapixel sensors in these cameras, although the
highest-resolution cameras are currently found in the so-called “medium
format” digital SLR arena, where cameras start out at $10,000! You can fit
standard interchangeable lenses to them while retaining all the sophisticated
autoexposure and autofocus modes originally introduced in their film
camera counterparts. As [ mention earlier, one feature pros demand is
speed. If you use a pro camera, you'll see just how this speed is applied.
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With lesser cameras, there is often a tiny time lag while the autofocus system Book |
locks in; with pro cameras, this interval is hard to detect. Chapter 2

With a pro camera, such as the one shown in Figure 2-8, you can usually snap
off pictures as quickly as you can press the shutter release, or else trigger the
motor drive continuous shot mode. You may be able to snap off 5 to 8 pictures
per second for as long as you like, or at least until the storage media fills up.
That can be a long time, because pro digital cameras usually accept humon-
gous storage options, such as 4GB (or larger) memory cards.
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Some pro dSLR cameras (as well as prosumer models) with interchangeable
lenses boost the effective magnification of your lenses as well, because the
sensors are smaller than the nominal 24-x-36mm 35mm film frame. A 35mm
lens or zoom setting has the same field of view as a normal lens on a film
camera. A 105mm portrait lens becomes a longer telephoto. However, some
of the latest professional cameras have a true 24-x-36mm sensor and can use
lenses at their marked focal lengths.

You can read more about the advantages and challenges of using a digital
SLR in Book III.

Figure 2-8: Professional digital SLRs have rugged bodies, extremely fast focusing and
shooting, and ultra-high resolution.
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Checking for Key Camera Features

Check out Book II, Chapter 1 for a close look at all the features to consider
for your digital camera. In this overview chapter, I provide a list of the key
features that you should think about. I discussed resolution earlier because
resolution is one of the key ways of categorizing cameras, but I've only
touched briefly on other features. Here’s a summary of what to look for:

4+ Resolution: Again, resolution determines how sharp your image will be,
how much you can enlarge a photo before the pixels start to become
distracting, and how much you can crop a photo and still be left with a
decent image that you can enlarge and manipulate.

4+ Lens: The lens is the eye of your digital camera. Look for the following in
your lens:

e You'll want good-quality optics that focus a sharp image on your
camera’s solid-state sensor. The best way to gauge the quality of the
lens is to take a test photo or two. A vendor’s reputation or lab tests
in magazines are other ways to evaluate a lens.

¢ The lens also needs enough light-gathering power to let you shoot in
reduced light levels. A camera’s light-gathering capabilities are meas-
ured in something called fstops, and I explain this in more detail in
Book II, Chapter 1.

e The magnification power of the lens (how large or small an image
appears to be from a particular shooting position) is another factor.
A digital camera’s lens magnification can usually be varied by zooming
in and out to make the image larger or smaller.

e Arelated factor, the zoom range, is another key characteristic to
look at. Where magnification tells you only how large or small the
image can be made to appear, the zoom range tells you the difference
between the two. As [ mention under the discussion of general
camera categories, some lenses have only a small zoom range, say 2:1,
whereas others have a longer range, up to 12:1 or more (which means
the image size can be varied up to 12X).

What’s the difference between magnification and zoom range?
Magnification deals purely with how large or small an image appears to
be. For example, one lens may extend from a 28mm (35mm equivalent)
to 85mm (35mm equivalent) magnifications, a 3:1 zoom range. Another
lens might go from 35mm to 105mm (both 35mm equivalents) and

also qualify as a 3:1 zoom range optic. However, the second lens would
provide more relative magnification.

4 Storage: The kind and amount of removable storage is another key
feature. The more storage space you have for photos, the more pictures
you can take before “reloading” your digital camera. Most cameras use
CompactFlash, Secure Digital, or other electronic “film” media. You can
find more on this topic in Book II, Chapter 1.
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4+ Exposure controls: Except for the least expensive models, all digital Book |
cameras include automatic exposure controls that adjust the amount of
light reaching the sensor based on the lighting conditions of your sub-
ject. If the illumination is low, an autoexposure system uses a wider lens
f-stop or exposes the sensor for a longer period of time. If there is a lot of
light, the exposure system reduces the amount of light reaching the
sensor. Cameras with more versatile automatic exposure controls let you
specify what type of exposure to use.
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For example, when shooting action, it’s often preferable to use the short-
est shutter speed possible to freeze the motion and to adjust the size of
the lens opening instead. Conversely, if you want a lot of your image to
be in sharp focus (say, objects very close to the camera and very far are
both important), you may be able to choose an exposure mode that
favors maximum depth of field. You probably want a digital camera that
can handle several different exposure modes and lets you set exposure
yourself. | explain more about these modes in Book II, Chapter 1.
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4+ Focus controls: Most digital cameras also have an automated system for
sharply focusing your images. Some are more versatile than others, and
many cameras also let you focus manually to ensure that the subject
matter you want to emphasize is the sharpest.

+ Viewfinders: Digital cameras generally have four ways to let you preview
and compose your images prior to exposure. The color LCD panel on the
back of the camera shows you the same image that the sensor is captur-
ing. The LCD is often hard to view in bright light, so digital cameras also
may have optical viewfinders that let you see a nonelectronic version of
the frame. More-advanced cameras might include a second LCD (EVF) in
the camera, where it is shielded from the glare of the surrounding light.
Single lens reflexes (SLRs) let you see an optical version of the picture
through the same lens used to take the photo. I explain more about your
viewfinder options in Book II, Chapter 1.

4+ Other equipment, other features: Finally, as you choose your digital
photography gear, think about accessories, such as tripods, filters,
add-on lenses, external electronic flash units, scanners, printers, and
additional stuff. Even the storage media you use to archive your photos,
such as CDs or DVDs, can all be important.

[ reveal the mysteries of these extra pieces of equipment in various parts
of Book II. This overview has given you enough to think about.
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Chapter 3: Acquiring Your
Digital Pictures

In This Chapter

1~ Transferring from your camera to your computer
» Scanning images

1~ Getting photos online or on Photo CD from a photo lab

H ow do you acquire digital photos? The quick answer is, “With a digital
camera!” However, the digital photography process involves more
than simply snapping a picture. Indeed, you can use other ways of acquiring
a digital picture that don’t even involve a digital camera. Scanners, for exam-
ple, can convert any printed image into a digital image. Some scanners, such
as those with slide scanning attachments or dedicated slide scanners,

can even capture color transparencies or negatives.

This chapter provides an overview of all the ways you
can acquire digital pictures and points you to chapters
that explore these topics in more detail.

Transferring Images from Your
Camera to Vour PC

The first challenge you have to face is getting your
digital images from your camera into your computer
so that you can edit them (if necessary), store them on
some archival medium (such as CD or DVD), and make
prints.

Today, transferring images to your computer is a fairly painless

process. It wasn’t always so. My first digital camera back in the last millen-
nium had no removable storage. It was bad enough that when the camera’s
internal storage was full, I had to stop taking photos. But what was even
worse was that it often took 10 to 20 minutes to move those photos from the
camera to my computer. The only option was an old-fashioned serial cable
that moved an image one bit at a time, like a line of soldiers, from the
camera to the serial port on my computer at about 64 kilobits per second.
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Even at a prehistoric resolution of 640 x 480 pixels, I had roughly 2.5 million
bits (307 kilobytes) to move per picture. So at best, I spent a minimum of 40
seconds transferring one photo. It seemed longer.

To make things worse, this was back in the days when PCs didn’t share
peripheral ports very well, so my computer really had only two functional
serial ports.  used one for my mouse, and the other for both a modem and
my camera’s serial cord. [ had to unplug one to use the other. This may seem
bizarre in these days of USB (Universal Serial Bus) ports, which enable you
to connect a mouse and dozens of other peripherals at once, and FireWire
connections, which speed files between computers.

Today, you have multiple options for transferring your images. [ can plug a
USB cable directly into my favorite camera and transfer multi-megapixel
images in a few seconds. [ also have a card reader that accepts memory
cards and lets me move images between the card and my hard drive as if the
memory card were another disk drive.

Card readers are so inexpensive these days that they are often built right
into computers or printers, as you can see in Figure 3-1, which shows the
slots of a reader included below the DVD drive in a Windows PC. Usually,
such a reader will be your best choice for transferring photos. Compared to
transferring using a cable connection, the reader is faster and uses less juice
from your digital camera’s battery.

MMC / 5D

hl;'::mpi_:dﬁulh I/1 Memory Stick

Figure 3-1: Card readers built into computers allow transferring photos quickly without the
need for a cable.

[ outline all the options and explain the pros and cons of each storage medium
in Book VIII. You can find everything you need to know about transferring
images from camera to PC or Mac there.
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Chapter 3

Another way to create a digital image is to capture an existing print or slide
with a scanner. As far as your image editor or printer is concerned, these
kinds of digital images are just as digital as those that began their lives in the
sensor of a digital camera.

Indeed, before digital photography became common, the only way most of us
who worked with images could acquire a digital picture was with a scanner.
Scanners remain a valuable tool for anyone who needs digitized graphics from
hard copy originals. The good news
is that the price of scanners has
come down since the late 1980s,
while the features have improved.
Whereas my first “real” scanner
(forgetting about toys such as the
ThunderScan, available for the
Macintosh in the mid-1980s) cap-
tured a whopping 16 levels of gray at
300 samples per inch, my latest has a
true resolution of 2,400 samples per
inch and can grab a few billion differ-
ent colors. It’s about 10 times faster
and includes a capable transparency
scanner. My first scanner cost me
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about $2,500; the list price of my Figure 3-2: Scanners have become less
latest is about $200. A typical scan-  expensive, thinner, faster, and capable of better
ner is shown in Figure 3-2. resolution.

You can find a lot of information about scanners in Book II, Chapter 4, but I
can summarize a lot of what you need to know here in this overview.

Kinds of scanners

A variety of nonprofessional scanners has drifted off into the fog of history.
My first scanner was a ThunderScan unit that (I am not making this up)
replaced the ink ribbon in an Apple ImageWriter printer with an optical
imager that captured a scan of a photo as it fed through the roller. Other
scanners have included the hand scanner of the early 1990s, which looked
like an overgrown mouse.

Yesterday’s sheet-fed scanners became obsolete but lived on for awhile in
the form of dedicated fax machines that sucked your documents past a
stationary sensor. The flatbed scanner, which looks and works a little like a
photocopier, has become today’s standard.
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é_‘,“‘ Today, unlike times past, you don’t have to agonize over what category of
scanner to buy. That should be obvious from the kind of scanning you want
to do:

4+ Flatbed scanners are used for scanning reflective copy, such as docu-
ments, photographs, articles torn from magazines, and other similar
material. You simply place the
original face-down on the scan-
ner’s glass platen, and a moving
bar with a light source and a
sensor (or a mirror that reflects
the light to a sensor located else-
where in the scanner) captures the
image a line at a time when you
close the lid and activate the scan-
ning software.

Some flatbed scanners have a
light source built into the lid (or
another component), as shown in
Figure 3-3. This light source can
transilluminate a negative, slide,
or transparency so that you can
use the flatbed to grab images
from transparent originals. These
scanners can do a good job in non- Figure 3-3: A light source built into the lid
critical applications. allows a flathed scanner to capture slides.

4 Slide scanners are specialized scanners designed to scan slides and
transparencies. They often have the higher resolution needed for scan-
ning the 24mm x 36mm area of 35mm slides and often cost quite a bit
more than flatbed scanners. There are also dedicated transparency
scanners for larger size film, too, such as 120/220 roll film and sheet film,
including 4-x-5-inch, 5-x-7-inch, and larger sizes. They're largely used by
professional graphics workers.

4+ Photo scanners are simplified scanners that convert snapshots to digital
format. Deposit your standard-sized photo in the scanner, and it grabs
an image for you to edit. Photo scanners are sometimes mated with
color printers so that you can make copies of prints as quickly as you
can feed them into the scanner. Although popular at one time, this type
of scanner is no longer widely available.

What to look for in a scanner

When shopping for a scanner, you’ll want to look for a few important things.
Here’s a quick summary (see Book I, Chapter 4 for more details):
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4 Resolution: Scanners generally have a lot more resolution than you need, Book |
measured in samples per inch (spi). You'll also see the terms dots per inch Chapter 3
and pixels per inch applied to scanners, even though scanners don’t have
dots (printers do) or pixels (monitors do). Scanner resolution varies from
600 x 600 spi to 2400 x 2400 spi or higher. Unless you're scanning tiny, very
high-resolution originals (such as postage stamps), anything more than
300 or 600 spi is overkill. [ explain why in Book II, Chapter 4. The difference
between 300 spi and 2400 spi resolution is shown in Figure 3-4.
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Figure 3-4: A 300 spi scan of a small, detailed object (left) isn’t sharp enough. The 2400 spi
scan (right) looks much better.

4+ Color depth: This is the number of colors a scanner can capture. The
color depth is measured using something called bit depth. For example, a
24-bit scanner can capture 16.8 million different colors; a 30-bit scanner
can grab a billion colors; and a 36-bit or 48-bit scanner can differentiate
between . . . zillions of colors. You'll never have an original with that
many different hues, however. In practice, the extra colors simply pro-
vide the scanner with an extended range (called dynamic range) so that
the scanner can capture detail in very dark areas of the image as well as
in very light areas.

4 Speed: Some scanners are faster than others. If you're scanning a lot of
photos, you’ll want one that works quickly.
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4+ Convenience: So-called “one-touch” scanners have buttons mounted on
the front panel so that you can trigger the scanner to make a copy (that’s
sent to your printer), scan to a file, route a scan to e-mail, capture text
with optical character recognition (OCR), or perform other functions.

4+ Bundled software: The best scanners are furnished with an easy stand-
alone software interface plus a more professional scanning program that
gives you total control over every scanning function. You also get drivers
that let you access these interfaces from within programs, such as
Photoshop. You may even get Photoshop Elements bundled with the
scanner, plus software to create panoramas, build Web pages, manage
documents, and do other fun stuff.

4 Accessories: Some scanners include sheet feeders (for scanning a stack
of documents) or can be fitted with them as an option. Others have slide-
scanning attachments or built-in slide-scanning tools. Depending on the
kind of work you do, these accessories can be a perk or a necessity.

Letting a Professional Do It

\\3

Sometimes you don’t need to convert an image to digital format yourself.
Professional services can do that for you. These range from stand-alone
kiosks at your local department store (with a built-in scanner and printer) to
services that your local photofinisher offers. When you take in your film for
processing, your local lab can give you the same set of prints or slides that
you have always received or return your images already scanned onto a
Kodak Photo CD or Picture CD. Some mail-order firms offer the same service.

As long as your images are being scanned anyway, your professional service
may post them on the Internet for you — as Web pages or as files that you
can download directly to your computer. You can find more about these
options in Book VIII.



Chapter 4: Editing or Restoring
a Photo Electronically

In This Chapter

1~ Deciding what can be done to restore and improve digital photos
1 Choosing which repairs to make first
1+~ Picking the right software for your image editing needs

1~ Solving common photo problems quickly and easily

R emember when getting free double prints of your photos was a big
deal? It was so convenient to have a spare copy of every photo on
the roll. With the advent of digital cameras and scanners, however, the
excitement of double prints has worn off. Today, it’s routine for your local
digital print lab to offer double prints of every shot you took with
your digital camera, along with an index print or CD with all
your images on it. In addition, you can make as many
prints as you want at home with your own printer.

Today, the most exciting part of photography is that
you no longer need to put up with images that
don’t look exactly like you want them to. While a
retail digital print lab can make many fixes to your
images, you can apply these adjustments in your
own computer with an image editor. Why put up
with damaged images or photos that are too dark
or too light if you can fix them electronically?

With digital photography and a good image editor, you
have the power to reproduce and repair your own photos
or the photos others have taken, whether they originated
digitally or were scanned from prints or slides. This chapter is an
overview of what’s possible with photo-editing software, which applications
do the best job for the money, and how to make some quick corrections

of common photographic problems, such as fixing red-eye and removing
dust spots.
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In this chapter, I also explain how you can improve the image quality and
content of your photos by removing the tell-tale signs of age, poor photo-
graphy, or bad lighting. (I even show you how to remove unwanted people or
things — ex-boyfriends/girlfriends and the like — from the picture.) If the
last remaining photo of a long-departed relative is looking shabby or has
faded with time, there’s no need for alarm or regret. Just open your favorite
image-editing application (some programs to consider are discussed later in
this chapter) and add color, remove spots, improve contrast, and in general
make the image look like new. For example, Figure 4-1 shows before and after
versions that illustrate how you can spruce up an old photo.

You can also remove unwanted content — that dumpster that nobody
noticed when the picture was taken or the brother-in-law you really don’t
miss — and replace it with more desirable stuff, such as a hedge, a pet, or an
extension of the background. You can make the photo look as though the
item was never there in the first place.

Figure 4-1: Here's an old photo that's faded and scratched (left) and spruced up in an image
editor (right).

Choosing an Image-Editing Program

In a digital photograph, you can fix just about anything — as long as your
image-editing program has the tools you need. You don’t want a program to
limit what you can do, but you don’t want to spend $600 when you could pay
just $100. This section helps you figure out what type of editor meets your
needs, and I offer you a guide to some of the different programs on the
market.
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Determining your needs

If you're using a powerful application, such as Photoshop Elements, the
repairs and improvements you can make are almost unlimited:

4 You can use a flexible and powerful set of selection tools to control
where the edits and repairs take place, preventing changes to areas of
the photo that are just fine as they are.

4+ You have access to a nearly unlimited set of brush tools for painting,
drawing, and erasing anything you want.

<+

You can use filters to blur and sharpen images.

4 You can work with a vast assortment of color, brightness, and contrast-
adjustment tools (see Figure 4-2) to fix the results of an overachieving
flash, a cloudy day, or old photo paper that allowed images to fade and
colors to change with time.

-
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Figure 4-2: Tinker with color, brightness, and contrast to bring images back to life.

If you're using Photoshop Elements, the tools at your disposal are virtually
the same set of tools found in the full version of Photoshop. Some of the fea-
tures that only hardcore professional photographers use have been weeded
out in Elements, but the basic set of tools and features is still there.

Checking out different applications

So how do you know which application to use? Your needs are your most
effective guide, but of course, your budget will have some impact as well.
After you start pricing these applications, you’ll notice that the prices vary
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from more than $500 to less than $50. How can that be? s the least expen-
sive software terrible? Is the priciest application great? No, and yes. It all
depends on what you want to be able to do, how intuitive you are with soft-
ware, and how much photo editing you’ll be doing.

You can find a more detailed comparison of the various software packages in
Book V, Chapter 3, but Table 4-1 gives you at least an overview of what vari-
ous applications have to offer. We discuss these and other applications in
more detail in the following sections.

Table 4-1 Overview of Image Editing Applications
Product Name Expensive? Mac or Easy Editing Capabilities/
rc to Use Interface
Adobe Photoshop  Yes, over $600 Both Yes Professionals hands-
down prefer this
program. You can
do quick fixes,
restoration, or just
about anything.
Photoshop No ($99 retail) Both Yes Great for the home
Elements user. Also good for
quick fixes and more
substantial editing.
Corel Paint No (about $99) PC Yes Similar to Photoshop
Shop Pro Elements.
Microsoft Digital ~ No (about $99) PC Yes Available in three
Imaging Suite versions, with addi-
tional clip art and
templates the main
difference between
them. Excellent for
those who need
design help.
Ulead Photo No (around $99) PC Yes Good, basic tools for
Impact photo retouching.
Corel Photo Yes (part of the PC No A fairly comprehen-
Paint CorelDraw sive set of retouching
suite, over $500) tools, but not quite as
rich as Photoshop or
Elements.
Corel Painter Yes (costs $499, PC Yes Consider as a com-
$199 for upgrades) panion to whatever

other retouching
software you buy; it
has painting features
that are not available
elsewhere.
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Adobe Photoshop CS2 and Photoshop Elements

Photoshop CS2 is the photo-editing software for professional photographers,
graphic artists, Web designers, and the like. Photoshop Elements was
designed to put a good number of Photoshop’s tools in the home and small
business user’s price range. The interface for these two products was similar
until the most recent versions of Elements arrived dressed in a spiffy new
interface. They're not “sit down and use it” applications. You'll want to read
the guide that comes with either editor or buy a book about the software

(or use Book VI of this title).

The top-of-the-line software (Photoshop) costs as much as $649 for a full
version, but it offers the most powerful set of image creation, editing, and
retouching tools you can lay your hands on. Photoshop Elements, which has
functions similar to Photoshop for the average person’s photo-editing needs,
is only $99. Considering that, it’s a steal at the price, and both Photoshop and
Photoshop Elements are available for both the Mac and Windows PCs. You
may even find Photoshop Elements bundled with your digital camera for free!

Corel Paint Shop Pro

Corel Paint Shop Pro is inexpensive (on par with Elements) and powerful.
The interface is pretty intuitive, and it lets you do all the standard image
editing stuff (resizing, cropping, rotating, color and contrast adjustments,
and adding textures). It has some quick and useful tools for eliminating red-
eye, scratches, tears, and so forth. If you feel intimidated by Photoshop or
aren’t big on using Help to figure stuff out, you’ll like Paint Shop Pro. It was
designed for regular folks, but it includes photographer-quality tools.

Corel PhotoPaint and Ulead Photolmpact

Applications like Corel PhotoPaint and Ulead Photolmpact are intended
as true competitors to Photoshop, although neither does everything that
Photoshop can do.

Corel Painter

Many serious digital photographers and artists own both Photoshop and
Painter because Painter’s natural media tools let you paint on image canvases
in ways that are completely different from what you can do with Adobe’s flag-
ship image editor.

Lower-end products, shareware, and freeware

The lower-end products — such as Ulead Photo Express and others you can
find by searching the Web — are great for quick adjustments to size, rotation,
and even simple color and contrast changes. If all you want to do is capture
images from your digital camera and make minor adjustments to their size
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and general quality before sending them to friends via e-mail, these packages
may be just what you need. If you really want to restore and edit photographs
for prints or Web pages, you’ll probably be happier with one of the more
powerful (and pricier) applications.

Want to find freeware and shareware for photo editing? Search for “Photo
Editing” at www.hotfiles.com or www. tucows . com. A search of either site’s
software libraries will yield a long list of downloadable freeware and share-
ware applications. Note that shareware is not free. If you keep and use the
product, be sure to pay its author or manufacturer — it’s the right (and
legal) thing to do.

Performing Photographic Triage

How do you decide what needs to be done to a given image? Well, some
problems are obvious. A torn photo (where the tear shows in the scanned
version) is in definite need of plastic surgery. A photo with a row of red-eye-
plagued children needn’t look like a lineup of demons. You can remove the
red-eye and return the little darlings to their normal states.

Some photos, however, have several problems, and you may not be sure
which problems to tackle first. There may be fading from age, scratches and
scuffs from improper storage, yellowing, stains, or maybe the picture was
too dark or too light from the start. If your photo suffers from two or more
problems, solving one might solve another if you attack them in the right
order. Here’s a series of tips to help you do a little image triage:

4+ Handle structural problems first. If there’s a torn corner or a rip or hole
in the photo, scan the image and repair the tear first in your image
editor so that you’re working with an intact “canvas” as you continue to
fix other problems.

4 Adjust light and dark problems before tinkering with color. Why?
Because if you add color to an image and then adjust brightness and
contrast, the color added with the software can become too bright or
too dark or can change to a color you don’t want.

4+ See if any of the content removal or replacing that you want to do will
solve other problems, as shown earlier in Figure 4-1, in which the miss-
ing left edge of the photo was fixed by removing the person standing
behind the boy on the bicycle. For example, if you need to get rid of a
person’s hand or shoulder, or some other content that was inadvertently
included in a shot, maybe replacing that content with something else
will also get rid of a big scratch that’s occurred on that part of the photo
as well.
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Making Quick Fixes oot
For the purposes of this portion of the book, I use Photoshop Elements to
demonstrate some quick fixes, or simple, fast techniques for solving the most
common photographic problems. You can find similar techniques in other
applications, assuming the applications can perform these tasks to begin
with. If you're still up in the air about which photo-editing program to use,
the inability to perform some of these quick fixes would be a good reason to
take one or more of your alternatives out of the running!
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Fixing red-eye

Red-eye results from the camera flash reflecting off a subject’s retina. We've all
had it happen, especially when taking pictures of children who get too close to
the camera and of pets, whose pupils are quite large, letting in a lot more light.
So what do you do when your niece’s eyes look like two red marbles? You can
use tools designed specifically to get rid of red-eye (see Figure 4-3), or you can
use conventional editing tools to exorcise the demons that have possessed
your image.

Red Eye tool
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Figure 4-3: This tool gets the red out!
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To use the Photoshop Elements new-and-improved red-eye tool, follow these
steps:

1. Click the Red Eye Removal tool; it’s about halfway down the Tool
Palette when it’s docked (or press Y to select it).

2. Go to the Options bar that runs just above the document window and
make sure the Pupil Size and Darken Amount are both set to 50%.

3. Drag a rectangle around one eye, as shown in Figure 4-4 (or just click
in the area of the pupil and let Elements locate the red-eye unassisted).

You don’t have to be too precise. When you release the mouse button,
the Red Eye tool locates the red pupil, removes the red coloration, and
darkens it. (It works only with red pupils; the yellow or green pupils
found in animals are not affected.)
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Figure 4-4: Drag a rectangle around the eye. You don't have to
be precise.

4. If the pupil is too dark, press Ctrl/38+Z to reverse the action and then
change the Darken Amount to a lower value and try again.

Your results should look like Figure 4-5.

5. Select the other eye, or try clicking inside the pupil. The Red Eye tool
works either way.
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Figure 4-5: The Red Eye tool removes the red coloration from the pupil.

If your image editing software doesn’t have a red-eye tool, you can still get
rid of red eyes. Doing so just requires a few more steps and tools:

1. Set your application’s paintbrush tool to a size that matches the
diameter of the red eye.

2. Manually choose a color to replace the red.

Choose a color that’s darker than the person’s real eye color so that the
colorization looks natural.

3. Zoom in tight on the eye so that you can apply the color to the right
spot.

4. Click with the brush to fill the red area.

This step should require just one click if your brush is set to the right size.

Removing dust spots

Dust spots and scratches are common problems for old photos or photos that
have been stored in desk drawers or shoeboxes or were tucked inside a book
or a wallet. If the front of a photo has been rubbing up against other stuff —
other photos, papers, pens and pencils — chances are that the photo has
highly visible scratches. Dust can collect in these scratches, compounding the
problem, or you may simply have scanned the photo without dusting it off
first. Mold, things spilled on the photo, or just places where the emulsion has
cracked and come off the photo can also create small, unpleasant blemishes.

Any image editing program provides the basic tools to clean up this sort of
defect. Although the Clone or Rubber Stamp tool (discussed later in this
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chapter) is useful for touching up dust, if the background is a solid color,
you can use your software’s Paintbrush tool instead, along with color selec-
tion tools, to correct the problem by following these steps:

1.

Use your program’s Eye Dropper tool to sample the color near the
scratch, spot, or stain. If you’re using Photoshop Elements, skip to
Step 2.

Most applications have an Eye Dropper tool for selecting a color in the
image and setting it as the paint color. You’'ll use the color you choose to
paint over your blemish.

. Click the Paintbrush in the tool palette to activate it, and if possible,

set the size of the brush so that you control how much color is
applied. (If you're using Elements, hold down the Alt/Option key
while clicking near the dust spot to sample the color; you don’t need
to access the Eye Dropper tool directly.)

Be sure to use a very small brush so you don’t paint over nonblemished
areas — to do so can leave obvious signs of the touch-up.

. Zoom in on the area you want to touch up and then click and drag in

the image to paint that color over the blemish, as shown in Figure 4-6.
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Figure 4-6: The Paintbrush tool can touch up dust spots on a solid background.



A\\J

Making Quick Fixes 49

If your image editing software has filters or other similar tools designed
specifically for cleaning up an image, you can use them instead of repairing
the spot or scratch manually. Photoshop Elements includes a Dust &
Scratches filter, which allows you to select the portion of the photo to repair,
and it provides settings so that you can control to what degree the photo is
cleaned up. Figure 4-7 shows the Dust & Scratches filter dialog box, which
you open by choosing Filter=>Noiser>Dust & Scratches.

To use the filter, follow these steps: [Dust & Scratches &)
o™

<=

1. Select the area to be repaired, using
any of Photoshop Elements’ selec-
tion tools.

2. Open the Dust & Scratches dialog
box by choosing Filter->Noiser>
Dust & Scratches.

3. Inside the dialog box, adjust the slid-
ers by dragging both the Radius and
Threshold sliders to the far left.

4. Ease back the Radius slider, drag-
ging it slowly to the right until you Ml L
see the scratches and spots in the
preview area disappear.

Bxius: [

Figure 4-7: The Preview window shows

You may have to tinker with the slid- how the settings affect the final results.

ers to achieve a pleasing result.

5. When you like how the preview looks, click OK to apply the repairs to
the selected area in your photo.

If the entire surface of your photo is damaged, you can select the whole thing
or repeat the filter procedure on several different selected areas. The latter
approach is probably best, unless the damage is absolutely uniform over the
entire image. If it isn’t, then you’ll benefit from applying different levels of
the Dust & Scratches filter to the different areas of the image.

Don’t go too far when removing scratches and dust because you could end
up with a blurry image or a portion thereof that looks obviously smoothed
out. If the photo is old or is clearly an amateur photo, nobody expects
absolute perfection, and going too far in removing every little tiny blemish
can have an undesirable effect overall. However, Photoshop and Photoshop
Elements share a handy feature under the Edit menu: You can choose to
revert to a previous version of your image — and you can do this in steps if
you go too far in the correction process.
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Correcting color

Colors on printed photos can fade, and scanning a photo can magnify this
problem. If you take a picture with a digital camera, you can lose color accu-
racy and depth, depending on the quality of the camera, the lighting at the
time, and the file format and quality you choose when you save the captured
image to your computer. No matter what the cause, though, your image-
editing software should offer at least one or two options for fixing the color
in a photo. These options are either automatic correction tools that do an
all-over sweep for bad color or manually controlled tools that allow you to
increase or decrease tones in your image.

In Photoshop Elements, the quickest fix is the Auto Levels command, which
you can employ by using the following steps:
1. Issue the Auto Levels command by choosing Enhancer>Auto Levels.

After it’s issued, the Auto Levels command goes over your entire image (or
a portion thereof if you made a selection first) and adjusts the color levels.

2. You can repeat the process for further adjustments or press Ctrl+Z
(38+D on the Mac) to undo it if you don’t like the results.

Figures 4-8 and 4-9 show before and after views of the same photo.
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Figure 4-8: Auto Levels can correct this photo . . .
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Figure 4-9: ... producing results that look like this.

Typically, even the lower-end image editing applications offer a similar tool for

correcting color quickly. If your application doesn’t offer this tool or doesn’t

do what you want, you can switch to
a more effective application.

Photoshop Elements offers a handful
of commands (each with its own
dialog box) that allow you to adjust
brightness, contrast, tones, hues,
and color casts. You can find these
tools on the Enhance menu, under
the Color and Brightness and
Contrast submenus. Figure 4-10
shows the dialog box that appears if
you choose Enhancer>Adjust Color=
Hue/Saturation. The box’s three
sliders are for adjusting Hue (color),
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Figure 4-10: Adjust multiple color attributes
all in the same dialog box.
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Saturation (amount of color), and Lightness (amount of white in the colors).
To use this and similar dialog boxes, simply drag the sliders for whatever
levels you are able to adjust (Hue, Saturation, and Lightness in this case)
and watch the Preview. When you like what you see, click OK to apply the
changes to your image. You can find out more about these specific tools in
various chapters in Book VI, which focuses on Photoshop and Photoshop
Elements.

Restoring, Replacing, and Removing
Photographic Content

When my aunt was a child, she liked to draw on photos, especially those
that included pictures of my mom. So we have a lot of old pictures with
crayon and pencil strokes on them, and many of those strokes run through
people’s faces and parts of the picture that you couldn’t crop away without
losing the charm of the image. Other photos in our family’s collection are
torn or ripped, bear deep scratches, and generally look tattered. I've sal-
vaged many battered photos by using Photoshop and Photoshop Elements
to replace the missing content. Various tools in these applications enable
you to take content from another spot in the photo and use that content
to rebuild what’s missing. For example, in the photo shown in Figure 4-11,
rough handling resulted in a tear, and an unfortunate fold cost this photo
its corner. Figure 4-12 shows the image after I repaired it.

Figure 4-11: A photo with tears and lost content.

Another problem you might encounter is unwanted content. Perhaps a truck
is parked in front of the house you're trying to sell, and you can’t take the
picture without including the truck. Never fear — if you have the right soft-
ware, you can easily get rid of the truck and replace it with a curb, grass, and
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even a few shrubs that may not really exist. You can do the same thing to get
rid of people in a picture or to add people (or pets!) to a photo when they
weren’t there the day the picture was taken. How do you think the tabloids
make it look like two people who haven’t really even met went to a party
together? Is that really Elvis in the background of Lisa Marie’s wedding? It’s
all a matter of taking existing content, placing it in the image, and leaving
unwanted or unimportant content in its wake.

Figure 4-12: | restored the missing parts by using other content
in the image.

Replacing missing or unwanted content

So you want to replace a missing corner, which was lost to a big rip or deep
scratch, or you want to cover up something that’s undesirable in the photo.
You can use a variety of tools, and most of the more powerful image editing
applications let you take content from one spot in the image and repeat it in
another spot. To finish the job, you may need tools to make the pasted con-
tent blend in, and those tools are normally available even in midrange image
editing applications.

The tools you use to replace the missing content or cover up the unwanted
content depend on the size of the area being filled. To cover a thin seam
(such as a deep scratch) or fix a tiny corner, you can use the Clone Stamp in
Photoshop or Photoshop Elements (other higher-end applications have their
own versions). If the missing or unwanted content represents a large area of
the image, it’s better to copy and paste content from one part of the photo to
another. [ explain both techniques in this section.

Figure 4-13 shows a shot of two gargoyles perched on the Cathedral of Notre
Dame in Paris. Unfortunately, a guard-rail protrudes on the image. The Clone
Stamp is the best bet for getting rid of that rail.
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Figure 4-13: Cloning can remove the guard-rail.

If you use the Clone Stamp, you can paint other content into the area that’s
lacking, filling as much or as little as you want. If you use the copy-and-paste
technique, you may have to paste repeatedly to fill in the missing content.

Fixing small areas
To replace content in a small area with the Clone Stamp, follow these steps:

1.

Click the Clone Stamp in the tool palette to activate it.

2. Choose an appropriately sized brush.

. Find the spot that contains the content you want to use to cover some-

thing else.

Zoom in if necessary to zero in on the spot.

. Press and hold the Alt key (or the Option key if you’re on a Mac) and

click to sample that spot.

Now, the software knows this is the area you want to clone and use
elsewhere. The size of your brush dictates the size of the sampled area.
You can set the brush size on the Options bar while the Clone Stamp is
active.

. Now, click the spot that you want to cover to deposit the cloned content,

as shown in Figure 4-14.

You can click over and over, and the cloned content appears wherever you
click.
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Figure 4-14: Your copied content is painted over the guardrail.

Be sure to turn off the Aligned option on the Clone Stamp Options bar so
that the original sampled spot is used as the source each time you click to
deposit the cloned content. If Aligned is on, the Clone Stamp continuously
resamples content, and you can end up with undesirable results.

Fixing larger areas
To replace larger areas with the Edit, Copy, and Paste commands, follow
these steps:

1. Using the Marquee or Lasso tool, select the area you want to use to
cover up something else in the image, as shown in Figure 4-15.

You can find more information about these selection tools in Book VI,
Chapter 1.

2. Choose Edit~>Copy from the main menu.
You can also press Ctrl+C on a Windows computer or 8+C on a Mac to
do the same thing.

This places a duplicate of the selected area in your computer’s memory,
and it waits there until you tell your software where to place the copied

content.
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3. Paste the content by choosing Edit->Paste from the main menu.
The keyboard shortcut for this is Ctrl+V for Windows and 88+V for Macs.

4. Click the Move tool in the Tool palette to activate it and then drag the
pasted content into the desired position.

5. Blur the edges of the added content so that it blends with the rest of
the photo.

If you're not sure how, read on.

Figure 4-15: Select the area you want to use to cover up
something else.

Adding the finishing touches
After you've positioned your cloned or pasted content, you can use the Blur
tool to blend any obvious sharp edges. To do so, follow these steps:

1. Click the Blur tool to select it.

2. Using a small brush size, scrub (brush) over the edges of the pasted
content to make the edges disappear.

The content should look as if it were always there, as shown in Figure 4-16.
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Figure 4-16: The guardrail and overlapping gargoyle are gone!

If you merge the layers of your image (Layer=>Merge Visible), the photo
becomes one layer again, and you can blur both the pasted content and the
surrounding content, all with one stroke.

Rearranging patrts of the picture

Moving part of your image requires selecting it with the Marquee or Lasso
tools (or the equivalent tools in the software you've chosen to use). After you
select the content, you activate the Move tool and then drag the selection to

a new spot.
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One thing to remember when moving content is that it leaves a hole where
the content originally was. The hole is filled with the current background
color, which is normally white. If you want to move content and also leave it
in place, press and hold the Alt key (or Option key if you're using a Mac) as
you drag. A duplicate of the content is moved, instead of the original con-
tent, as shown in Figure 4-17.

P If you're wondering whether you can move content between images, the
answer is yes — if you're using the higher-end image editing applications.
Some of the lower-end applications don’t allow more than one image to be
open at a time, making it impossible to drag content from one image onto
another or to easily use the Edit=>Copy command in one image and then use
the Edit=>Paste command in another image.

Original Duplicate

Figure 4-17: Holding down the Alt/Option key as you drag a selection creates a duplicate
of the selection.
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Getting vid of unwanted content Book
Chapter 4

After you select an area of your image by using any of the selection tools,
you can press the Delete key to get rid of it. Doing so leaves a hole, and the
background color shows through. You can then use any tool you want —
such as the Paintbrush or the Paint Bucket (which fills the area with a solid
color or a pattern) — to occupy the hole where the content used to be.
You can also use the Clone Stamp or the Edit=>Copy and Edit=>Paste com-
mands to fill the hole with content from elsewhere in the image.
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Another way to get rid of content in one place, but to not lose the content
altogether, is to use the Edit=>Cut command. This command removes content,
but instead of simply deleting it forever, the content is placed in the com-
puter’s memory (in a space called the Clipboard), where it waits for you to
paste it somewhere. This is similar to the copy-and-paste process, except for
the fact that the Cut command deletes the selected content where it currently
is. The Paste portion of the process is the same, whether you use Cut or Copy.
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Chapter 5: Storing and Organizing
Vour Digital Photos

In This Chapter

1 Understanding your organizational options
1 Choosing the right tools to organize and store your photos

1~ Keeping your treasured photos safe

LVe all have at least one box or drawer full of photos that we've never

had the time to put in an album — vacation photos, pictures of the

family at holiday dinners for the last 10 years, even collections of vintage

photos, all waiting for someone to take them out of their envelopes and put

them in a book so that people can actually look at them. What about your

digital photos? They may not be languishing in a drawer, but if they’re

in different folders scattered all over your hard drive, they may . emoto Manager

as well be in a shoebox under the bed. _ew Create Tools Database _

The most important things you can do with your digital

images are first to organize them and then to store
them in a way that keeps them safe from accidental ‘ 1
erasure, unwanted changes, or loss due to fire,
flood, or computer meltdown. You can easily

achieve the proper organization and reliable stor- _Dscasss _Pscasss _psr:ase?
age of your digital images, and plenty of tools are at

your disposal to make it all happen. The key, how-
ever, is to do it — so don’t put it off any longer!
601

Organizing Your Photos

When it comes to taking control of your photo organization, you

have a few different approaches to choose from. Your personality, your
computer, and your access to the Web all dictate your choice. Here are
some approaches to consider:

-_.'l -

T

4 Setting up a file structure on your computer

4+ Working with software that makes it easy to organize and store your
images and view them through a special interface

4+ Organizing and storing your images in an online gallery
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What do I mean about your personality influencing your choice of organiza-
tional tools? If you're a very organized person who enjoys straightening out
closets and dresser drawers, always knows where the remotes are, and
always puts things away after using them, then using the file management
tools already on your computer might appeal to you.

If, on the other hand, you aren’t too tidy and often forget where you left your
glasses or your keys, you might prefer either using software that organizes
things for you or posting your images to an online gallery. The tidy person
might like these latter approaches as well.

Using your computer’s file-management tools

You already have some great tools for organizing your images, and the tools
have been on your computer all along. If you're running Windows, you have
My Computer and Windows Explorer right there at your fingertips. If you're
using a Mac, you can use the file-management tools that you've already been
using to create folders on your desktop or hard drive.

Using these tools requires devising some sort of filing system — one or more
folders that will help you categorize your images. You might start with one
called Photos and create subfolders called, perhaps, Family Photos, Vacation
Pictures, and Scanned Vintage Photos. You can create folders on your com-
puter for whatever groupings fit the pool of images you have. After you create
the folders, all you have to do is move your images into the appropriate fold-
ers and remember the folder names when you store new images in the future.

Using Windows Explorer to store and organize your photos

Working with folders under Windows is pretty basic but deserves a review in
the context of organizing your digital image files. To create folders to store
your images by using Windows Explorer, follow these simple steps:

1. Choose Start~>Programs=>Windows Explorer.

You can also right-click the Start button and choose Explore from the
context menu.

2. When Windows Explorer opens, click the C: drive icon (see Figure 5-1).

If there’s a plus sign next to the icon, click that plus sign to display the
folders currently on the drive. If there’s a minus sign next to the icon,
that means you can already see all the folders.

The Windows Explorer window is divided into two panes: the Folder
pane on the left and the Content pane on the right. When you click a
drive or folder in the Folder pane, that drive’s or folder’s contents are
displayed in the Content pane. This two-sided display makes it possible
to drag items from one folder to another simply by displaying the source
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(where the content is now) and target (where you want the content to
be) folders in the separate panes.

If you don’t see the Folder pane, you can open it either by choosing
View=>Explorer Bar>Folders or by clicking the Folders button on the
toolbar.
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Figure 5-1: Navigate your hard drive to locate the folder you want to use.

3. If there’s a My Pictures or other folder you want to use as the basis
for your image organization, click it. If you want to start a new
folder for your photos, choose Filer>Newr>Folder from the menu bar.

If you go the New Folder route, a New Folder appears in the Content
pane, with its temporary name highlighted, waiting for you to type its
real name (see Figure 5-2).

4. If you go the New Folder route, give your new folder a name and press
Enter to confirm it.

With a folder created to house some or all of your photos, you can begin to
place them in a single location. You can also make subfolders in that main
folder to categorize your photos. For example, if you have a Photos folder,
you can create a Vacation Photos subfolder and a Baby Pictures subfolder to
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keep those two, distinct photo subjects separate. Figure 5-3 shows just such
a folder system.
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Figure 5-2: Create a new folder if necessary.

To create subfolders of the main folder, simply click the main folder to select
it (on the left side of the screen, in the Folders pane), and repeat Steps 3

and 4 from the preceding steps list. You're going to use the File>Newr>
Folder command to create a new folder, but because you're in an existing
folder when you do it, the new folder appears inside the active folder.

The process is like taking one of those green hanging Pendaflex folders and
putting one or more manila folders in it. The green folder represents the main
Photos folder, and each of the manila folders is the same as the subfolders
you create to categorize your photos. You can create as many subfolders as
you want, and even create subfolders within subfolders. The folder hierarchy
can become as complex as you want or need it to be, but be careful not to
make managing files so cumbersome that the process becomes confusing
when you need to place an image in the right folder.

If you don’t need to categorize your photos by subject, consider creating
folders that separate your photos by date. You can have a separate folder
for individual years, months, or weeks, depending on how prolific a photo-
grapher you are.

Working with My Computer

You can also use the My Computer program on your Windows-based computer,
and it works much like Windows Explorer. Instead of a two-paned window, how-
ever, you have separate windows for each drive and folder on your computer.
The command for creating new folders is the same (FilecwNewr>Folder), but
you have a visually different environment in which to work when creating and
using your folders. Figure 54 shows the main My Computer window, displaying
the C: drive, D: drive, E: drive, and other computer components.
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Figure 5-4: You can also use My Computer to navigate your hard drive.
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Organizing your photo images on a Mac

If you're using Mac OS, you can easily create folders to store your photos
and other digital images. You can choose to store them on your hard drive
or make them quickly accessible from your ever-visible desktop.

To create a new folder in OS X, follow these steps:

1. Choose Filer>New Folder from the menu bar.

A folder called Untitled Folder appears on the desktop. You can also
press Shift+8+N, or Control-click the desktop and choose New Folder
from the context menu that appears.

2. Give your folder a short yet relevant name that will make it easy to
find the folder in the future.

3. You can leave the folder on the desktop or open your hard drive and
drag the folder there.

If you store the folder on the desktop, it is quickly available at any time,
but you also make it quickly available to anyone using your computer.
If you don’t want people poking around in your photos, store the new
folder somewhere on your hard drive other than the desktop.

4. If you want folders within the folder you just created, open the folder
and then repeat Steps 1 through 3 to create the subfolders.

You can duplicate an existing folder by choosing Filem>Duplicate. Alternatively,
drag the existing folder to a new location on the same hard drive while holding
down the Option button; this approach makes a copy of the original folder and
leaves the original where it was.

Using photo album software

Setting up a series of folders to store and categorize your images is easy
enough. To view them after they're stored, however, you either have to

open them in the software you used to edit/retouch them or use the generic
software that came with your computer to see the images. If you find that
inconvenient (and you probably will, especially if you like to look at and
work with your images frequently or to view them side by side), you’ll proba-
bly be glad to know that several great photo-album applications are on the
market. (Ilist a selection of them in Book V, Chapter 3.) These applications
enable you to view one, two, or several of your images at the same time, all
in one easily navigated workspace.

Figure 5-5 shows a group of photos viewed through Adobe Photoshop
Album, which started out as a standalone application but is now part of
Photoshop Elements. Similar programs are often furnished with cameras and
software bundles from other vendors.



Organizing Your Photos 07

fi D Family Phoros - Adobe Photoshap Album ™\
O ooy I - - (W —
— pa— |
Sa—
N [taTm mpomsasomnes Al on L2108 214N | | Des
LDt Vemest Frstl w Detan & —
\ =y

Figure 5-5: Album software makes it easy to organize, find, and retrieve your images.

Want more? Do a search at your favorite search site for “Photo Album
Software” (use the quotation marks to make sure the search engine uses the
full phrase). You can also check Web sites, such as www.buy.com and www.
amazon.com, where you can do similar searches for the photo album soft-
ware each site has to offer.

Your criteria for actually selecting photo album software is a personal thing.
You may prefer ease of use and not care if you don’t get a lot of fancy func-
tionality. If you want a lot of bells and whistles, you may not mind it if the
product is a little more complicated to use. Some photo album software
serves as both an organizational tool and a vehicle for creative display of
your photos, and some just do the latter job. If you already have a system for
organizing your images, you may not need software that does double duty.

You can download and test many photo album products for free (with a time
or number-of-uses limitation), making it possible to test-drive two or more
products before plunking down any cash and making a commitment. It pays
to shop around if you plan to use this software frequently. ThumbsPlus,
available for evaluation at www.cerious.com/download.shtml, is shown in
Figure 5-6. Other popular album applications include ACDSee, iPhoto, and
Adobe Bridge, a standalone program included with many Adobe products,
including Photoshop and Elements.
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Figure 5-6: ThumbsPlus is a popularimage management application.

Here are some features to look for when choosing photo album software:

4+ Ability to categorize and classify each photo, using built-in or custom-
designed categories

4 Provision for adding your own captions and other annotations

4+ Search capabilities, so that you can locate all the images classified as
Vacation pictures by using keywords such as beach and 2006

4 Sorting abilities, so that you can permanently or temporarily arrange
your photos by filename or other criteria (these features go hand-in-
hand with search capabilities)

4 Features for uploading from your local album to your own Web space
or picture sharing services, such as SmugMug (www . smugmug . com) or
PBase (www.pbase.com)

4 Viewing capabilities that include looking at single photos and arranging
them into slide shows

4+ Simple image-editing features such as cropping, resizing, and rotating, so
that you can make small changes to your pictures without firing up your
image editor
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Using online galleries

You probably already e-mail photos to friends, sending the images as mes-
sage attachments that the recipients must open to view. Then, your recipi-
ents can save any images they want to keep on their hard drives. There may
be a better way to share your images, assuming you don’t mind having your
images posted on the Internet, by using online galleries to display your
photos. This section is an overview of using online galleries. You'll find a
complete look at this valuable tool, including a discussion of some leading
gallery providers in Book VIIL

The online approach to image distribution has some great advantages and
some drawbacks. Check out the advantages first:

4 You can avoid the hassle of having to e-mail photos to lots of different
individuals because you're placing all your photos on one Web site.
All you have to do is let people know to check the site for your images.
This makes it possible to share images that are larger than some e-mail
services can handle (many services have a 2MB limit).

4 You can share more images with more people. Anyone with an Internet
connection can view the images without owning any special software —
other than a browser, which people need to surf the Web anyway.

4+ You have yet another relatively protected repository for your images.
If you lose the original files, you can download them from the online
gallery.

Possible disadvantages — and only you can decide if they are real
disadvantages — are as follows:

4 Your photos are on the Web, and, unless you use the provider’s privacy
provisions, anyone can view them. This can expose you and your family
to people with whom you would not normally share your vacation,
holiday, and otherwise personal photos. You have to be careful about
posting photos that show your house number, last name, or any other
identifying information.

4 Most online galleries charge a fee for providing space on their site for
your photos. The fees are usually reasonable, but compared to e-mailing
photos, which is free (you're already paying to have e-mail anyway), the
cost may be more than you're willing to pay.

To find an online gallery to post your photos, you can search online for
“Online Galleries”. You'll see quite a few that are devoted to actual artists
(and this may be of interest if you are an artist), and some that are for the
general public to use. If you add “+free” to the search criteria, you’ll ferret
out those sites that offer the space for free or that will let you test their
services for free or for a limited time.
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Archiving and Backing Up Photos

Not all your photos will require instant, easy access. Vacation photos from the
past — especially if you visited a not-too-exciting place — may be a waste of
valuable hard-drive real estate. But what if you don’t want to delete those
infrequently viewed images? There’s no reason to make rash decisions; you
can simply archive the ones you don’t need to access quickly or frequently. If
a photo is valuable to you on some level in the long run, but you don’t imagine
wanting to look at or print it within the foreseeable future, just save it to

disc —a CD or DVD.

Backing up your best shots

First, because you've already organized your photos (assuming you've
read the beginning of this chapter), you should already have your photos
categorized and know which ones are especially dear to you. These cher-
ished shots need to be backed up, stored in some way in order to protect
them from anything that can happen to your computer or your photo
albums (printed or electronic).

Your backup options are simple:

4 Store the photos on a spare hard drive. This isn’t as freaky as it sounds.
Plug-in external hard drives that connect to your USB or FireWire port
may cost less than $100, and they can make a large-capacity, relatively
inexpensive backup system. External hard drives in sizes of 160GB or
less can cost less than $100 and will hold thousands of images. You can
unhook the drive and store it in a safe place when you’re not actually
using the images you’ve backed up. Of course, hard drives are prone to
failure (eventually), and even an extra external drive shouldn’t be used as
your only backup destination.

4 Write them to a disc, using a CD or DVD burner. This method enables
you to store up to 800MB on a single CD, or almost 5GB on a DVD. If your
computer already has a burner in it or attached to it, all you need is a
package of writeable CDs or DVDs. The discs are so inexpensive that you
can make two copies. To be 100-percent safe, you should plan on copying
your important discs to fresh media every few years. Even good-quality
CDs and DVDs can “fade” over time. Also plan to copy your media to
whatever new kind of storage replaces CDs and DVDs five or ten years
down the road. You don’t want to end up with “antique” discs and no
way to access them!

4 Store them online. Many Web sharing sites also can provide you with
a sort of backup for your images. It’s best to use these as a secondary
backup (sort of as a backup to your backup) because there’s no guarantee
how long these services will be around!
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Using CD-R and CD-RW

For a brief period, virtually every computer sold came with a built-in CD
burner. These have largely been supplanted by combo drives that can burn
both CDs and DVDs. So it’s very likely that your computer has a burner of
some sort that can make archival copies on CDs.

With the ability to write to a CD, you now can save up to 800MB of data on a
very reliable medium. Unlike older magnetic media, such as floppy and Zip
disks (remember them?) that could be ruined by exposure to magnets, heat,
cold, sunlight, water, and rough handling, CDs are pretty stable. Other than
breaking or scratching them, you can’t really hurt them. They might eventu-
ally fade on their own, but it won’t be your fault!

Although DVDs are the new (if temporary) standard, the old CD format still
has a lot of life left in it. Here’s a refresher course in CD media:

4 Writeable CDs come in two types: CD-R and CD-RW. CD-Rs can be written
to (the R stands for Recordable), but only once. CD-RWs can be written to
and erased, and written to again.

4 You can use a CD-R or a CD-RW like a floppy or Zip disk by using a mode
called Packet Writing. In that mode, you can copy files or groups thereof
to the CD. However, you can’t interrupt the writing process as you can
with a floppy or Zip disk, and the process takes a bit longer.

4 Commercial CDs (like the discs that contain software or audio tracks) are
pressed from a mold. CD-Rs and CD-RWs are marked with a laser, creating
spots that represent data (in binary form). CDs are virtually indestructible
(unless you crack, break, or severely scratch them) and can withstand a
sunny day in the car or a night below freezing in that same glove box. Even
so0, CD-Rs and CD-RWs shouldn’t be exposed to direct sunlight or extreme
heat, although they are less vulnerable to such conditions than floppy or
Zip disks.

DUD storage

DVD burners have largely replaced CD-only burners in most computers.
Indeed, the older single-layer, 4.8GB DVD drives are themselves being phased
out by double-layer drives that can record 8.5GB of data. In the home theater
arena, there’s even a bit of fierce competition going on between Blu-Ray style
and HD-DVD formats, which can handle as much as 50GB of information!

For the digital photographer, plain old 4.8GB DVD drives make a lot of sense
until the technology settles down more. For one thing, single-layer DVDs

cost much less than half what dual-layer blank discs sell for. And you can be
assured that your dual-layer drive will read your old single-layer discs when
you do migrate. The only real problem with sticking with the older technology
right now is that the 4.8GB drives are becoming harder to find.
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Like CDs, DVDs also come in more than one variety:

4 DVDs (the prerecorded kind) come with stuff prewritten to them. You
can view what’s on them, but you can’t erase and then rewrite to them.

4+ DVD+R and DVD-R discs (note the use of the plus and minus signs) can
be written to only once. The plus/minus varieties are separate formats,
but most drives and burners can read both types. The -R version can be
slightly more compatible with some television DVD players.

4+ DVD+RW and DVD-RW discs can be written to, erased, and written to
again.

4+ DVD+/-RW burner/players can play DVD discs and play or write to DVD+/-R
and DVD+/-RW discs.

If your older computer has a DVD player in it, that doesn’t mean you can
write to DVDs; it simply means you can play them. To write to a DVD,
you need the burner version.

4+ DVD Dual Layer discs require a dual-layer compatible drive or player.

Offsite storage for maximum safety

If your photos are so precious that you’'d be devastated if anything happened
to them, or if they’re important for legal, financial, or other compelling rea-
sons, don’t risk losing them to a fire or burglary. You can store your archives
off-site in one of three ways:

4+ Use a bank safe deposit box.
4+ Use a safe located in a secure storage facility.

4+ Arrange to keep one of two archive copies with a friend or family member.

If you save your precious images to a CD or DVD, you can make two sets and
store one set offsite, selecting one of the aforementioned places based on
the level of security you need. The bank could burn down, but the safe
deposit boxes are usually in or near the vault and are protected from very
high temperatures, even in the event of a fire. If you keep a safe in a paid
offsite storage space, the place is likely to be fireproof or well-protected by
sprinklers and video cameras, so it’s probably more secure than your home.
If neither of these is an option, find a friend or relative you trust and give the
extra set to him or her.



Chapter 6: Printing and
Sharing VYour Pictures

In This Chapter

»~ Making prints while you wait
1 Choosing among printer categories
1 Recommended print sizes

1+~ Sharing the wealth (of pictures you’ve taken)

u ntil the cost of those huge flat-panel digital displays that hang on the
wall like a picture frame dip below their current stratospheric price
levels, you'll probably want to use hard-copy prints of your best digital

pictures to decorate your home or office. You'll also find that prints are

more fun to pass around when you’re sharing your vacation with
coworkers. And have you ever tried to tuck an electronic
image of a loved one in your wallet?

No, prints are here to stay. Digital technology is just
making prints easier for anyone to produce. Instead
of stacks of photos of every single picture you've
ever taken (plus shoeboxes full of “lost” negatives),
you can have great-looking enlargements of the
photos you want to keep, perfectly cropped and
carefully corrected in your image editing program.
The ability to make prints is one of the best things
about digital photography.

An alternative to sharing prints is sharing your pictures
online through commercial sharing services or your own
personal Web space. Such options let friends and colleagues
view your photos even if they aren’t close by.

This chapter provides a quick overview of printing and printers and picture
sharing services. You can find a lot more detail in Book VIIIL.
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Creating Prints on Demand

One of the reasons you’ll want a printer for your digital camera is the sheer
joy of being able to produce your own prints any time in only a few minutes.
If you're used to dropping off negatives at a local photofinishing outlet and
then waiting hours or even overnight to get sparkling 5-x-7-inch enlargements,
you’ll love your color printer.

For example, on the day [ began this chapter, | was called over to my daugh-
ter’s school to take a picture of her science class performing the infamous
Egg Drop experiment. [ snapped off a couple shots of carefully-cushioned
eggs surviving (hopefully) a two-story plummet and then ran home and
made two 5-x-7-inch enlargements (one for the class, and one for our local
newspaper). It actually took longer to write the caption for the newspaper
than it did to print the photos. Less than 30 minutes after the last egg fell to
an untimely end, I returned to the school with prints in hand. Try that with a
film camera!

Color printers have never been cheaper or more ubiquitous. Our local super-
market sells $50 inkjet printers in the school and office supplies aisle, just
across from the microwave ovens. It’s a 24/7 market, too, so if I'm ever stuck
in the middle of a project at 3 a.m., [ can dash out and pick up some ink or
even a whole new printer before sunrise.

Here are your main options for making prints from digital cameras:

4+ Use your local MegaMart’s print kiosk. These typically accept a broad
range of digital media, from CompactFlash and Secure Digital film cards
to CDs or Picture CDs. They let you choose a photo, crop, rotate, and
resize your pictures, maybe add some text, and perform other simple
manipulations using a touch-screen video display. When you’re happy
with your picture, press a button and wait a few minutes until your
photo emerges. If you don’t make many prints, this can be a viable
option. The quality will be equal to or better than the prints you can
make at home.

4+ Try out your retailer’s digital lab. You didn’t think that photofinishers
would roll over and play dead after film was abandoned by a fickle
public, did you? Although dropping off your film for overnight process-
ing may be an activity that’s riding off into the sunset, many finishers are
building a thriving business from making prints, enlargements, and spe-
cialty items from your digital images. Many retailers now have in-store
digital minilabs that can accept your digital film and produce prints
while you wait. There are many advantages to this approach. For one
thing, your retailer can probably make prints a /ot more cheaply than
you can, can do it faster, and can give you better quality.

4 Do it yourself with an inkjet printer. Inkjet printers can produce prints
that look exactly like traditional silver-based photographs, on glossy or
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matte paper, at a cost of about $1.00 for large prints and about $0.25 per
snapshot. Most digital photographers own an inkjet printer, and unless
you are very fussy, they’ll do the job for you.

Upgrade to alternative technologies. Other types of printers, such as
dye-sublimation printers, thermal wax printers, and solid wax printers,
do a great job with color photos. Of these, only dye-sub printers are still
easy to find, with Kodak and Olympus among the vendors offering high-
quality dye-sublimation printers that are actually economical enough to
compete with inkjets. You can find more information about all these
printers in Book II, Chapter 4.

Getting the Most from Your Printer and Supplies

If you want to get the best from any of these printers, just follow a few

simple tips:

4 Calibrate your monitor so that what you see is what you get in your

prints. Check the manual that came with your image editing software for
instructions on calibrating your monitor to your application.

Use the best-quality glossy photographic paper you can afford. You can’t
go wrong using the paper recommended by your printer manufacturer.

Clean your inkjet’s print heads from time to time and keep the paper
path clean to avoid visible lines or blurry prints.

Wait until your prints are completely dry before you touch them. Wet ink
can smear easily, which spoils a $1 investment.

Have fun with those special printing media offered to let you make trans-
parencies or T-shirt transfers, print on fabrics, or create greeting cards.

Don’t ruin a perfectly good sheet of paper by making a print that’s too
large for your digital camera’s resolution (and thus comes out a bit fuzzy-
looking). Table 6-1 shows good sizes and maximum sizes for typical digital
camera resolutions, past and present.

Table 6-1 Recommended Print Sizes

Camera Resolution Good Size Maximum Size
640 x 480 pixels 2% x 3% 1n. 3% x5in.
1024 x 768 pixels 3% x5in. 5x7in.
1280 x 960 pixels 4x6in. 8x10in.
1600 x 1200 pixels 5x7in. 11 x 14in.
3000 x 2000 pixels 8x10in. 16 x 20 in.
3600 x 2400 pixels 8x10in. 20x 30 in.
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Sharing Your Photos

You can always e-mail your photos to friends and colleagues, but there’s a
better way. You can post them to your own Web site or use one of the com-
mercial photo sharing services. You can share your vacation photos, pictures
from school, and brag shots of your new house or car, or you can create an
online holiday newsletter.

Your ISP (Internet Service Provider) probably provides some free Web space
you can use to create pages for your pictures. Check with your provider for
instructions on how to use this space. Even easier is using the services pro-
vided by online companies like SmugMug, Yahoo!, and PBase. Their Web sites
lead you hand-in-hand through the process.

If you use an online sharing system or online gallery to display your images,
you'll find that many of them offer some space for free. In the case of an
online community, such as America Online, your monthly fee to AOL includes
access to the company’s AOL Pictures (formerly You've Got Pictures) feature,
which enables you and others to view your images online. You get free Web
space, too, which you can use to store and display your photos.

Other commercial sharing services known as online galleries allow you to
post your images for free in exchange for posting a few ads on your Web
pages. Other sites make their money through software they sell, such as
image editing or photo album applications.

Some sites, like Kodak’s EasyShare Gallery, let you upload your photos for
viewing but also offer the ability to send picture postcards and order prints,
enlargements, mugs, T-shirts, and other related items.

Sound intriguing? Check out Book VIII for more on sharing your photographic
treasures online.



Book |I
Building Your
Digital
Photography
Studio

The 5th Wave By Rich Tennant
@& MNaq T

ME*\

==

] —y
O =
\ 1
]
|

“My God ! T've gained 9 pivels!”




n this minibook, I show you how to assemble a

suitable digital photography arsenal, with
explanations of all the key features of the weapons
at your disposal, including camera equipment,
computer gear, printers, and cool accessories like
tripods, electronic flashes, and (if you're going the
digital SLR route) add-on lenses.

[ also give you in-depth explanations of key
features, including zooms, viewfinders, storage
options, and whether you really do need a gazil-
lion megapixels of resolution. You'll find out how
to set up your computer, transfer pictures from
your camera to your hard drive, and archive your
photos effectively for posterity. I also explain
some of the more puzzling aspects of printers and
scanners and show you how a few accessories can
make a dramatic difference in the quality of your
photos.




Chapter 1: Choosing the
Right Camera

In This Chapter

1~ Selecting a camera category

1~ Key components of digital cameras

+~ Evaluating lens requirements

1+~ Understanding sensors and resolution
1 Choosing exposure controls

1+~ Selecting exposure options

1~ Exotic digital camera capabilities

+~ Finding a camera that’s easy to use

Goosing the right digital camera has gotten a lot more
exciting recently! Digital single lens reflex (dSLR)
cameras — the ones that have interchangeable
lenses and show you an optical (not electronic)
preview image through the same lens that takes the
picture — have dipped under the $1,000 price point | | |
and are nosing around the $600 neighborhood, —_—_— == '
making them a reasonable choice for many more = = |
serious amateur photographers. Affordable
8-megapixel (and up) cameras provide sharper,
better pictures without busting your wallet. Digital
cameras are becoming smaller and easier to use and
are packed with special features we never dreamed were
possible as recently as a year ago. This is a great time to be
choosing a digital camera, whether you're a snapshooter or a
dedicated photo hobbyist.

Yet, selecting the right digital camera isn’t as daunting a task as it might
appear to be on the surface, even with the increased number of features and
options to choose from. Most of the leading vendors of digital equipment
produce fine products that take great pictures. It’s really hard to go wrong.
All you need to do is a little homework so that you’re aware, when you make
your purchase, of the features you need — and features you don’t need. The
vendors write their brochures and ad copy so that those who don’t sort out
features and benefits ahead of time might think that every feature is essential.
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Choosing a Camera Category

Trust me: They're not. The ability to shoot several pictures consecutively,
each using different color settings to make sure that one picture is perfectly
color-balanced, might sound cool, but it’s not something many people need
every day. But if you find yourself constantly taking pictures under varied
lighting conditions, and color accuracy is very important to you, a feature
like that might be a lifesaver. Only you can decide for sure.

The key is having the upfront information you need to wisely choose the
camera that has the largest number of your must-have features — and a nice
sprinkling of nice-to-have features — at a price you can afford. In Book I,
Chapter 2, you can find an overview of the choices you need to make. There,
you can find an introduction to the chief things to consider, which are

4+ Lens requirements

4+ Viewfinder options

4 Sensor resolution

4+ Exposure controls

4+ Storage options

4+ Ease of use
This chapter looks at each of these considerations, plus others, in more detail,
with a brief mention of the newest digital SLR cameras (which are covered
more exhaustively in Book III). Although much of the information can help you
select a camera, you can also find some basic explanations of digital camera

nuts and bolts that will be helpful as you take pictures. If you ever wanted to
know what shutter speeds and lens openings do, this is your chance.

Choosing a Camera Category

Digital cameras fall into several different categories, each aimed at a particular
audience of buyers, as well as particular kinds of applications for them. You
can find an extended discussion of camera categories in Book I, Chapter 2.
However, as a recap, the major types include

4+ Web cams: Web cams are cheap TV cameras that also offer low-resolution
full-motion and still images. They’re fun to use and essential for things
like videoconferencing. They aren’t covered in this book because most
don’t have the kind of image quality and capabilities required for serious
photography.

4+ Camera phones: Camera phones are those multipurpose cell phones that
also have photographic capabilities built in. Some have 2-megapixel or
better resolution that exceeds the picture quality available from some
$500 digital cameras from only a few years ago. In Japan, cell phones with
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cameras built in have already cut heavily into the market for one-time-use
film cameras. Folks who sometimes forget to take their digital cameras
with them wouldn’t be caught dead without their cell phones, so they're
always ready for the kind of spur-of-the-moment photography that single-
use cameras have traditionally served. I'm not covering these useful (but
specialized) devices in this book (even though I own and use one myself),
nor cameras built into other products, such as personal digital assistants
(PDAs). None of them are intended for use as a primary camera.

Point-and-shoot models: These entry-level digital cameras, priced at
$100-$200, offer 4 to 5 megapixels of resolution (although it’s becoming
very difficult to find a 4-megapixel camera in stores), simple lenses (usu-
ally with zoom), and autoexposure. I recently tested a 6-megapixel camera
with a 3X zoom lens and 32MB of built-in memory (a memory card was
optional) that could be purchased for $169! Clearly, even the most basic
point-and-shoot cameras are gaining resolution and features almost faster
than we can keep track. This kind of camera is an excellent choice for
someone looking for a basic camera with few manual adjustments, and for
casual shots that will be enlarged no more than about 5 x 7 inches.

Intermediate models: Priced in the $200-$400 slot, intermediate digital
cameras have 5- to 8-megapixel resolution, a 3:1 or 5:1 or better zoom
lens, and Secure Digital (SD), xD, or CompactFlash storage. Many have
close-up focusing, burst modes that can snap off seven or more frames
in a few seconds, and some manual controls. The average snapshooter
would be very happy with a camera in this category and would be
satisfied with the few tweaks that can be made to add a little creativity
to selected photos.

Advanced consumer models: In the $400-$800 range, you can find
deluxe digital cameras with roughly 6 to 10 megapixels of resolution,
decent 5:1 to 12:1 zoom lenses, lots of accessories, optional exposure
modes, and a steep learning curve. These cameras are easy to operate
so the average snapshooter can use them with a little training and prac-
tice. Yet, they are also versatile, with features like electronic viewfinders
and manual settings, that serious photographers can invoke for those
special picture-taking situations.

Prosumer non-SLR models: Serious amateurs and some professional
photographers use these. They cost $600—$800 and have all the features
you could want, including 8 to 10 megapixels or more of resolution, the
highest-quality lenses, an electronic viewfinder (EVF), and every acces-
sory you can dream of. Expect automatic and manual focus, multiple
automated exposure modes, and motor drive multishot capabilities.
(Read more about motor drive capability in Book IV, Chapter 5.)

Prosumer SLR models: The prosumer SLR is very nearly a whole new
category of camera, created in 2003 when Canon introduced the Digital
Rebel for $999 (with lens), and other vendors, including Nikon and
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Pentax, followed. In price, there is some overlap with the prosumer non-
SLR cameras. However, the true SLR type offers interchangeable lenses
and other features found in the traditional advanced-amateur favorite.

Professional models: Professional-quality digital SLR cameras used to
cost $5,000 and up and had 6-14 million pixels of resolution. Today, you
can still pay around $5,000 or more for a pro camera (without lens), and
resolutions now go up to 22 megapixels, but some very fine professional-
worthy models are available for a few thousand dollars less, too.

The manufacturers of the top-end cameras are feeling the pressure of
competition from the sub-$1,000 digital SLRs, so you can expect prices
to drop even further as features proliferate. However, professional pho-
tographers will continue to pay a premium for these cameras because
they frequently operate more quickly, allowing the pro to grab shot after
shot without pausing for breath. They’re rugged, too, which means they
can withstand the harsh treatment pros often subject their equipment to
(not because they’re mean, but because they're working).

You can find some general tips in Book I, Chapter 2 that can help you deter-
mine what category of camera you should look for. Read here, though, for
the lowdown on everything you need to consider.

Examining the Parts of a Digital Camera

If you're very new to digital cameras, you might be wondering what all those
buttons, LEDs, and windows are for. Here’s a quick introduction to the key
components of the average non-SLR digital camera. Not every camera will
have all these features, and some will have additional features not shown in
Figures 1-1 and 1-2.

+

+

Shutter release: Pressing this button halfway locks exposure and focus;
press all the way to take a picture.

Control buttons: Miscellaneous control buttons might turn on/off close-up
mode, automatic flash, or other features; set picture quality; or activate
the self-timer.

Shooting mode dial: Most cameras use this button or dial for changing
among different scene modes (such as Night, Portrait, or Sports), adjust-
ing automatic or manual exposure choices, selecting Movie mode, or
switching into close-up mode.

Microphone: This captures audio for movie clips and voice annotations;
it can even activate a sound-triggered self-timer.

Focus-assist light: This is an auxiliary illumination source that helps the
camera focus in dim lighting conditions.



+

<+
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Focus-assist light Electronic flash
Microphone Optical viewfinder Shooting
mode
Shutter release Control buttons dial

Battery compartment Docking port Tripod socket

Lens cover Zoom lens

Figure 1-1: The front of a typical digital camera.

Electronic flash: This provides light under dim conditions or helps fill in
dark shadows.

Optical viewfinder: This window, which doesn’t show exactly the same
view that the lens captures, is for framing and composing your picture.

Zoom lens: This magnifies and reduces the size of the image, taking you
closer or moving you farther away.

Lens cover: This protects the lens when the digital camera is turned off.

Tripod socket: This allows you to attach the camera to a firm support,
such as a tripod or monopod, plus other accessories, such as an external
flash bracket.

Docking port: Some cameras have a special dock that can be used to
transfer photos, recharge the batteries, make prints, or perform other
functions.

Battery compartment: This contains the cells that power the camera.

Power switch: Here is where you turn the camera on or off.
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Indicator LEDs

Optical viewfinder

Mode dial Control button Shutter release | File-save LED

LCD panel Cursor pad USB port

Display control | Print/e-mail photos Memory card slot

Picture review Set/Execute button

Figure 1-2: The back of a typical digital camera.

Indicator LEDs: These indicators show status, such as focus and expo-
sure, often with green and red go/no go LEDs (light-emitting diodes).

LCD (liquid crystal display) panel: This shows the sensor’s view of
an image before exposure, shows preview images after exposure, and
displays status, photo information, and menus.

Display control/Menu button: This controls the amount of information
shown in the LCD and produces menus. Some digital cameras have multi-
ple buttons for recording menus, setup menus, and special functions.

Picture review: Press this button to review the pictures you've already
taken.

Print/e-mail/share photos: Some digital cameras allow printing directly
from the camera to compatible printers or marking pictures for printing
or e-mailing later.
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4 Cursor pad: Use this to navigate menu choices. Many digital cameras
use the cursor buttons to activate frequently accessed features, such as
flash options, macro mode, exposure value adjustments, and a self-timer.

4+ Set/Execute button: Press this to activate a feature or set a menu choice
to the current selection.

<+

Memory card slot: This accepts digital memory cards.

4+ USB port: Use this to connect your camera directly to your computer or
to a printer via a USB cable.

4+ File-save LED: This light usually flashes or lights up to indicate that an
image is currently being saved to the memory card.

4 Power zoom control: Press this to zoom the lens in and out.

Evaluating Your Lens Requirements

The lens and the sensor (or film, in the case of a conventional camera) are
the two most important parts of any photographic system. The lens gathers
the light from your scene and focuses it onto the capture medium, digital

or analog. The sensor or film transforms the light into something that can
be stored permanently and viewed as a picture after digital or chemical
processing.

Sharp lenses and high-quality sensors (or film) lead to technically good
images; poor lenses and bad sensors lead to poor photos. Indeed, in one
sense, most of the other components of a camera are for your convenience.
Theoretically, you could mount a simple lens on one end of an oatmeal box,
focus it on a piece of film or a sensor affixed to the inside of the other end of
the box, and make an exposure by covering and uncovering the lens with a
dark cloth. Of course, the digital version of this science fair project would
require some additional electronics to handle the captured signal, but such
a system could work.

When you’re choosing a digital camera, the first thing to concentrate on is
the lens furnished with it. You probably don’t need to go into as much detail
as I'm going to provide, but understanding the components of a camera lens
does help you use your optics as much as it helps you choose them. The
major things you need to know fall into four simple categories:

4+ The optical quality of the lens itself: Just how sharp is the piece of glass
(or, these days, plastic)? The better the lens, the better it can capture —
resolve — fine details. In most cases, the optical quality of digital camera
lenses marches in lockstep with the price of the camera and the resolution
of the sensor. Even at the low and medium ends of the price spectrum,
digital cameras have good-quality lenses that usually can resolve a lot
more detail than the 4- to 5-megapixel sensor can capture.
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Understanding How Lenses Work

Camera vendors have been mass-producing lenses like these for film
cameras for decades, and any film camera can capture a lot more detail
than an inexpensive digital camera. At higher price levels, lenses have
better-quality optics, which are necessary to keep up with the detail-
capturing capabilities of 6- to 8-megapixel (and higher) sensors.

4 The amount of light the lens can transmit: Some lenses can capture
larger amounts of light than others, generally because they have a
greater diameter that can transmit more light. This factor, called lens
speed, is a bit more complicated than that. Think of a 1-inch-diameter
pipe and a 2-inch-diameter pipe and visualize how much more water
(or light) the wider pipe can conduct; now you’re thinking in the right
direction. Lens speed, in part, controls how low of a light level you can
take pictures in. If you take many pictures in dim light, you’ll want a
faster lens. I look at this factor in greater detail later in this chapter.

4 The focusing range of the lens: Some lenses can focus closer than
others. The ability to get up-close and personal with your subject matter
can be very important if your hobbies include things like stamp or coin
collecting or if you want to take pictures of flowers or bugs. Indeed,
close-focusing can open whole new worlds of photography for you,
worlds you can explore in more detail in Book IV, Chapter 2.

4+ The magnification range of the lens: Virtually all digital cameras have a
zoom lens, which allows you to vary the amount of magnification of the
image. You might be able to take your basic image and double it in size
(a 2:1 zoom ratio), triple it (a 3:1 zoom), or magnify it 12X or more
(a 12:1 zoom). The zoom range determines how much or how little of a
particular subject you can include in an image from a particular shooting
distance. As you might expect, the ability to zoom enhances your creative
options significantly. At the widest settings (wide-angle settings), you
can take in broad sweeps of landscape, whereas in the narrowest view
(telephoto), you can reach out and bring a distant object much closer.

Understanding How Lenses Work

You don’t need to have a degree in optical science to use a digital camera,
but understanding how lens openings (£stops) and some other components
work can help you use those components more effectively.

Lenses consist of several optical elements made of glass or plastic that focus
light in precise ways, much like you focus light with a magnifying glass or
with a telescope or binoculars. The very simplest lenses, like those used on
the least expensive digital cameras, are fixed focal length lenses, usually com-
prising just three or four pieces of glass. That is, the elements can produce
an image only at a single magnification. You find these in the simplest point-
and-shoot cameras that have no zooming capabilities. There aren’t many of
these around, but I did run into a camera with no “real” zoom recently: an
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extra-compact model that used a 3:1 digital zoom as a substitute for optical
zooming capabilities.

Most digital cameras have zoom lenses, which have very complex optical
systems with 8, 10, 20, or more elements that move in precise ways to pro-
duce a continuous range of magnifications. Zoom lenses must be carefully
designed to avoid bad things, such as stray beams of light that degrade the
image bouncing around inside the lens. For that reason, when choosing a dig-
ital camera with a zoom lens, you need to pay attention to the quality of the
image. All 4:1 zooms are not created equal; one vendor might produce an
excellent lens with this range, whereas another might offer a lens that is less
sharp. Among digital cameras with similar or identical sensors, lens quality
can make the biggest difference in the final quality of an image. You'll discover
how to select the best lens for your needs as we go along.

You can get a top-quality lens and still save some money if you know how to
interpret digital camera specifications. Many vendors share lenses and sen-
sors among similar models in their product lines. I tested two cameras from
the same manufacturer that had identical resolution and lens specifications,
but one model was more compact, was outfitted with a rechargeable battery,
and included rubber gaskets that made it water resistant. (It also cost $100
more!) A penny-pinching photographer who doesn’t mind a tiny bit more
bulk, is willing to use AA batteries, and doesn’t plan any photography in rain
showers could buy the less expensive version and save enough money to
buy some extra memory cards or other accessories.

Magnifications and focal lengths

Comparing zoom ranges of digital cameras can be confusing because the
exact same lens can produce different magnifications on different cameras.
That’s why you usually see the zoom range of a digital camera presented
either as absolute magnifications or in the equivalents of the 35mm camera
lenses that the zoom settings correspond to.

Zoom range doesn’t relate to lens quality. You'll find excellent 4:1 zooms and
average 4:1 zooms. However, the longer the zoom range, the more difficult it
is to produce a lens that makes good pictures at all zoom settings. You should
be especially careful in choosing a lens with a longer zoom range (8:1 or
above); test the camera and its lens before you buy. However, lenses from the
major manufacturers (Canon, Sony, Nikon, Fuji, and so forth) are all generally
quite good.

Until the advent of digital cameras, figuring the magnification of consumer
camera lenses was relatively easy because, in recent years, most consumer
(and the workhorse professional) film cameras used a standard film size —
the 35mm film frame — which measures a nominal 24mm x 36mm. Some
cameras also used Kodak’s now-discontinued Advanced Photo System (APS)
film format, which produced images in three different configurations.
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Optical zoom versus digital zoom

Non-SLR digital cameras have two kinds of
zooming capabilities: optical and digital. Optical
zoom uses the arrangement of the lens ele-
ments to control the amount of magnification.
Usually, optical zoom is the specification men-
tioned first in the camera’s list of features.
Digital zoom is a supplementary magnification
system in which the center pixels of an image
are enlarged using a mathematical algorithm to
fill the entire image area with the information
contained in those center pixels.

Digital zoom doesn’t really provide much in the
way of extra information; you could zoom in on

an image in your image editor if you like.
However, digital zoom is a way of turning a 4:1
zoom into an 8:1 (or better) zoom lens even if the
results arent as good as those you’d obtain with
atrue optical 8:1 zoom. | tend to discount digital
zoom capabilities when buying a camera
because | want the sharpest picture possible,
and many of the digital zoom pictures I've taken
have looked fuzzy and pixelated. The feature
doesn't cost you anything, and you can usually
switch it off so you won't accidentally grab a
digital zoom picture by mistake.

The magnification of any particular lens with a standard film size is easily cal-
culated by measuring the distance from the film the lens must be positioned
to focus a sharp image on the film. (This is the focal length of the lens.)

By convention, in 35mm photography, a lens with a 45-50mm focal length is
considered a normal lens. (The figure was arrived at by measuring the diago-
nal of the film frame; you can calculate the focal length of a normal lens for
any size film or digital camera sensor by measuring that diagonal.)

Lenses with a shorter focal length, such as 35mm, 28mm, 20mm, or less, are
described as wide-angle lenses. Those with longer focal lengths (such as 85mm,
105mm, or 200mm) are described as telephoto lenses. We've lived happily with
that nomenclature for more than 75 years, since the first 35mm camera was
introduced. Wide-angle and telephoto images are shown in Figure 1-3.

Then came the digital camera, and all the simple conventions about focal
lengths and magnifications went out the window. For good and valid techni-
cal reasons, most digital camera sensors do not measure 24mm x 36mm. You
wouldn’t want a sensor that large (roughly 1" x 1.5") anyway in a compact
digital camera because the camera would have to be large enough to accom-
modate it. In addition, as with all solid-state devices, the larger a device such
as a sensor becomes, the more expensive it is to manufacture. Sensors that
are as large as the full 35mm film frame are available for an increasing
number of digital SLR cameras, which means the magnification effect I'm
about to describe doesn’t apply for those models.

Most sensors for non-SLR cameras are more likely to measure, say, 16mm x
24mm or less. Even the larger digital camera sensors might be no bigger
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than about 38mm x 38mm. So, a normal lens on one digital camera might be
8mm, whereas another normal lens on another camera might be 6mm. A 4:1
zoom lens can range from 8mm-32mm or 5.5mm-22mm. What a mess! How
can you compare lenses and zoom ranges under those conditions?

Figure 1-3: Telephoto (top) and wide angle shots (bottom) provide different perspectives on
a subject.
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Camera vendors have solved the problem by quoting digital camera lens
focal lengths according to their 35mm equivalents. If you're already familiar
with 35mm camera lenses, that’s great. If you're not, at least you have a stan-
dard measurement to compare with. That’s why you often see digital camera
zoom ranges expressed as “35mm-135mm equivalent (roughly 4:1)” or some
similar expression. You can safely use these figures to compare lenses in
your quest for the perfect digital camera.

Because digital camera lenses have such short focal lengths in the first
place, most models tend to be deficient in the wide-angle department.
Expect to see most digital cameras with no better than a 35mm-28mm wide-
angle equivalent. That’s barely acceptable because 35mm isn’t very wide. If
you really need a wide field of view, consider a wide-angle attachment that
fits on the front of your lens.

What focal length (equivalents) do you look for? Your preferred range will
depend on what kind of photos you want to take. If you shoot architecture or
indoor photos, you’ll want the shortest focal length possible. An alarming
number of digital cameras seem to have settled on a 38-39mm (equivalent)
focal length as their widest setting. There are several reasons for that. First,
a lens with that meager wide-angle field of view is easier to design (and usu-
ally more compact) than one with a broader perspective.

In addition, a lens with a particular magnification will have a longer tele-
photo effect if you're starting from a base focal length that’s narrower to
begin with. Consumers tend to get more excited about long telephotos than
they do about wider wide-angles, even though both perspectives have an
important place. Table 1-1 shows how a 4:1 zoom lens gains a more impres-
sive telephoto “look” when the vendor snips millimeters from the wide-angle
portion of the range.

Table 1-1 4X Zoom Lenses (35mm Equivalents)
Minimum Focal Length Maximum Focal Length
28mm 112mm

32mm 128mm

35mm 140mm

38mm 152mm

Hey, wouldn’t you prefer a 152mm medium telephoto over a 112mm short
telephoto? You would until you find yourself with your back up against the
wall trying to take a picture of an entire (albeit moderately small) room and
discover that your 4X zoom lens would give you no more than the field of
view of a 38mm lens. You might be happier with a lens that has a wider mini-
mum focal length but which accepts a telephoto attachment for those times
when you really need to reach out and touch something.
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Lens apertures

The lens aperture is an adjustable control that determines the width of the
opening that admits light to the sensor. The wider the aperture, the more
light that can reach the sensor, making it possible to take pictures in dimmer
light. You can think of an aperture as the pupil of your eye. When it’s bright
outside, your pupils contract (and you squint), letting in less light. When it’s
dim, your pupils dilate.

A narrow aperture reduces the amount of light that can reach the sensor,
letting you avoid overloading the imaging device in very bright light. These
lens openings are used in tandem with shutter speed (the amount of time the
sensor is exposed to the light) to control the exposure. (I explain more about
exposure later in this chapter.) Your digital camera needs a selection of lens
apertures (fstops) so that you can take pictures in a broad range of lighting
conditions.

F-stops aren’t absolute values; they’re calculated
by measuring the actual size of the lens opening
as it relates to the focal length of the lens, using a
formula that I won’t repeat here. The easiest way
to visualize how f-stops work is to imagine them
as the denominators of fractions. Just like % is
larger than % or %, /2 is larger than f/4 or {/8.

The relationship is such that as the amount of
light reaching the sensor is doubled, the f-stop
increases using an odd-looking series of numbers:
f/2 is twice as large as /2.8, which is twice as large
as f/4, and so on through {/5.6, {/8, f/11, f/16, and  Figure 1-4: Lens opening,
f/22 (which is just about the smallest f-stop you'll ~ f-stop, aperture — all mean
encounter in the digital realm). Figure 1-4 shows a the doorway that light passes
lens opening that’s partially closed down. through to the sensor.

If you're taking photos in automatic mode, you don’t need to know what
f-stop you're using because the camera selects it for you automatically. Your
digital camera probably displays the f-stop being used, however, either in
the viewfinder or on an LCD panel, and the information can be helpful. Just
remember these things (see Figure 1-5):

4+ The larger the f-stop (the smaller the number), the more light that is
admitted (faster). An f/2 lens (small number, large f-stop) is a fast lens,
whereas one with a maximum aperture of f/8 (larger number, smaller
f-stop) is slow. If you need to take photos in dim light, you want to buy a
camera with a fast lens.

4 The smaller the f-stop (larger the number), the more of your image that
is in sharp focus. (More on this later.)
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4 As the f-stops get smaller (larger number), exposure time must be
increased to let in the same amount of light. For example, if you take a
photo at f/2 for one-half second, you need to double the exposure time to
one full second if you stop down (reduce the aperture) to f/4. I look at
exposure a little later, too.

¢ JOIG

/2.8

/5.6 11 116

Figure 1-5: As the f-stop gets larger (the number gets
smaller), more light is admitted.

Typically, you'll find that among non-SLR digital cameras, the speed or maxi-
mum aperture of camera lenses is smaller than is common among 35mm film
cameras, and the range of available apertures is more limited, too. For exam-
ple, even an inexpensive snapshooter 35mm film camera might have an f/1.9
lens (pretty fast), and serious photographers with 35mm SLRs probably own
f/1.4 or faster normal and wide-angle lenses. Although zoom lenses usually
have smaller maximum apertures, in the 35mm film world, f/2.8-f/3.5 are
common numbers.

In the digital camera realm, things are a bit different primarily because the
very short focal lengths of the lenses are more difficult to design with large
lens openings. So don’t be alarmed if your favorite digital camera has an f/4
or f/5.6 maximum aperture. You might even find that the lens is labeled
f/4-£/5.6 because the effective widest opening can vary as a lens is zoomed in
and out. A lens might have an f/4 opening when zoomed out to 38mm but
only {/5.6 at its maximum telephoto setting of 152mm. (In most cases, as the
focal length increases, the lens opening itself moves along with the optical
glass, so the opening is farther away from the sensor and looks smaller.)

To make things really interesting, your digital camera lens might have only a
limited number of different f-stops available, perhaps f/4, /5.6, and /8, or
maybe none at all. You won’t miss the lack of f-stops: Modern electronic shut-
ters are fast enough to provide the proper exposure without smaller lens
openings. Further, in 35mm photography, smaller lens openings have been
used to increase the range of sharpness (called depth of field). As you can
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read in Book IV, Chapter 2, though, the short focal length of non-SLR digital
camera lenses usually means that just about everything is sharp, anyway.

Focus range

The focus range of a digital camera is simply how close it can be from a sub-
ject and still create a sharp image. Digital cameras vary in their close-focusing
(also called macro) capabilities. If you want to photograph flowers, hobby col-
lections, items for sale on eBay, or anything else up-close, you want to make
sure that your camera is up to it. Close focus can vary from model to model.
Some vendors deem anything less than about a foot as macro capability. Other
cameras take you down to 1/2 inch from your subject. Here are some things to
consider when evaluating focus range:

4+ There’s such a thing as too close. When you get to within a few inches of
your subject, you'll find that the subject is difficult to light. The camera
itself can cast shadows and keep sulfficient light from reaching your sub-
ject. You'll find more about lighting close-ups in Book IV, Chapter 2.

4+ Some lenses don’t allow close focus at all zoom settings. You might
want to step back a foot and zoom in to get the best view of your sub-
ject. However, some lenses don’t allow automatic (or even manual)
focus at longer zoom settings. Some restrict macro capabilities to
midrange or wide zoom settings.

4 Close focusing is tricky. You want to make sure your digital camera
includes automatic macro-focusing capabilities so that you don’t have
to focus manually when shooting up tight to the subject.

4+ Keep attachment friendliness in mind. If your favorite digital model
doesn’t have sufficient built-in macro options, see whether you can
attach close-up lenses to the front of your lens. Not all digital cameras
can accept screw-on attachments of this type.

Exposure controls

Because light levels vary, digital cameras must vary the amount of light
reaching the sensor. One way to do that is to change the f-stop, as described
earlier in this chapter. The second way is to alter the length of time that the
sensor is exposed to the light. This is done either electronically or with an
actual mechanical device — a shutter — that opens and closes quickly to
expose the sensor for a set period — the shutter speed.

Like f-stops, shutter speeds are the denominators of fractions. The larger the
number, the less light reaches the sensor. Typical shutter speeds include 1/60,
1/125, 1/250, 1/50, and 1/1000 of a second. Your digital camera readout might
show them as 60, 125, 250, 500, or 1000 because the numerator is always 1.
However, a recent trend has been to include the numerator anyway to avoid
confusion with longer shutter speeds, which are whole numbers. Otherwise,
you’d have no way of telling whether an 8 in the viewfinder means 1/8 second
or 8 seconds.
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Cameras (chiefly film models) that use mechanical shutters might have only
exact intervals, although most film cameras have electronic shutters these
days. Electronic shutters aren’t limited to fixed incremental values and can
provide you with any actual interval from a few seconds through 1/2000 (or
sometimes even 1/4000) of a second. The traditional shutter speed values
are useful only when calculating equivalent exposures.

For example, suppose a basic exposure were 1/250 of a second at f/16 (which
is a typical exposure for a digital camera in bright daylight). If you wanted to
stop some fast-moving action, you might want your camera to switch to
1/500 of a second to freeze the movement with the shorter exposure time.
(You can find out more about stopping action in Book IV, Chapter 5.)

Because you’ve cut the amount of light in half by reducing the shutter speed
from 1/250 to 1/500 of a second, your camera needs to compensate by dou-
bling the amount of light admitted through the lens. In this example, the lens
is opened up from /16 to f/11, which lets in twice as much illumination.

Usually, all this happens automatically, thanks to your digital camera’s
handy autoexposure modes, but you can set these controls manually on
some models if you want. It’s probably a better idea to choose a different
autoexposure mode (described later) that gives you the flexibility you need.
Sometimes, you'll look at an image on your LCD review screen and decide
that the picture is too dark or too light. A digital camera’s autoexposure
modes can take care of this, too. When shopping for a digital camera, you'll
want to look for the following exposure options.

Plus/minus or over/under exposure

With these modes, you can specify a little more or a little less exposure than
the ideal exposure that your camera’s light-measuring system determines.
These adjustments are called exposure values (EV for short), and most digi-
tal cameras let you fine tune exposure +/— about 2EV, using half- or third-stop
increments. The most conveniently designed cameras have the EV adjustment
available from one of the main buttons on the camera, such as the Up-cursor
key. Beware of cameras that make you wend your way into the menu system
to make an EV adjustment. Fortunately, after it’s set, the EV setting “sticks”
so that you can continue to take pictures in the same environment with the
modified setting.

Full autoexposure

With this option, your digital camera selects the shutter speed and lens
opening for you by using built-in algorithms, called programs, that allow it
to make some intelligent guesses about the best combination of settings.
For example, on bright days outdoors, the camera probably chooses a short
shutter speed and small f-stop to give you the best sharpness. Outdoors in
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dimmer light, the camera might select a wider lens opening while keeping
the shutter speed the same until it decides to drop down to a slower speed
to keep more of your image in sharp focus.

Some digital cameras have several autoexposure program modes (sometimes
called scene settings) to select from, so if you're taking action pictures and
have chosen an action-stopping mode, the camera tries to use brief, action-
stopping shutter speeds under as many conditions as possible. These program
modes are different from the aperture/shutter-preferred modes described next
because they frequently include other factors in their adjustments. They might
have names like Sports, Night, Night Portrait, Landscape, Fireworks, or Portrait.
I used a camera with a scene setting called Cuisine (I kid you not), which
(after a little digging) I discovered also increased the sharpness and color
richness of the picture to supposedly make food pictures look better. Some
cameras have both an Auto (A) and Program (P) setting.

Aperture-preferved/shutter-preferred exposure

These options let you choose a lens opening (aperture-preferred) or shutter
speed (shutter-preferred), and then the camera automatically sets the other
control to match. These settings might be indicated by A or S markings —
commonly, Av and Tv (Time value). For example, by choosing shutter-
preferred, you can select a short shutter speed, such as 1/1000 of a second,
and the camera locks that in, varying only the f-stop.

Unlike the programmed modes described in the preceding section, if your
camera finds that the selected shutter speed, for example, can’t be mated
with an appropriate aperture (it’s too dark or too light out), it might not take
a photo at all. I've run into this at soccer games when I've set my camera to
an action-stopping shutter speed, but clouds dim the field so much that even
the largest lens opening isn’t enough to take a picture. Figure 1-6 shows an
action shot taken with the camera set on shutter priority.

Full manual control

With this option, you can set any shutter speed or aperture combination you
like, giving you complete control over the exposure of your photo. That means
you can also completely ruin the picture by making it way too dark or much
too light. However, complete control is good for creative reasons because
seriously underexposing (say, to produce a silhouette effect) might be
exactly what you want.

Other factors to consider

In addition to exposure options themselves, you must consider other factors
when evaluating the exposure controls of your dream digital camera. Here is
a quick checklist of those you should look out for:
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Figure 1-6: Choosing shutter priority lets you select an action-stopping shutter speed.

Sensor sensitivity: Like film, sensors have varying degrees of sensitivity
to light. (For film, this is its speed.) The more sensitive the sensor is, the
better it can capture images in low light levels. Most digital cameras have
a sensitivity that corresponds roughly to that of ISO 50 to ISO 100 film (so-
called slow film), and the specs often use that terminology. Many cameras
let you specify the sensitivity, increasing from the default value of, say, ISO
100 to ISO 400 or even ISO 800 (fast) to give you a “faster” camera.

Unfortunately, upping the ISO rating usually increases the amount of
random fuzziness — noise — in the image. It’s like turning your radio up
really loud when you’re driving a convertible with the top down. The
wind flying past your ears tends to cancel out some of the audio informa-
tion that your too-loud radio produces. Increasing the ISO boosts image
information while increasing background noise in the image. If you plan
to shoot many pictures in very dim light, any camera you buy should be
tested first to see whether ISO settings can be set manually. Then check
how noisy the pictures become when you increase the sensitivity.

Measurement mode: Just how does your digital camera’s exposure
system measure the light? Sometimes it measures only the center of the
picture (which is probably your subject anyway); sometimes, it might
measure the entire frame and average out the light that the sensor sees.
You don’t always want the camera to measure the light the same way.
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Measuring a center spot sometimes produces the most accurate read-
ing. Other times, such as when the scene is evenly lit, an averaging
system works best. On still other occasions, say, when there is a lot of
sky in the photo, you might want the camera to measure only the light
in the lower half of the picture. Many cameras have multiple exposure
modes that allow you to choose what part of the image is measured.
One clever exposure system I've used works in conjunction with the
camera’s automatic focus, selecting the part of the image that is in
sharpest focus to calculate the exposure.

4+ Compensation systems: Many exposure systems can sense when a pic-
ture is backlit (most of the light is coming from behind the subject) and
add exposure to make the subject brighter. Sophisticated cameras can
analyze your scene and choose an exposure mode that best fits each
individual picture, compensating for potential trouble spots in the
photograph. Or the camera might have an override to the exposure
system, allowing the sensor to receive more light from backlit subjects
when you choose to activate it.

4+ Manual exposure: If you're seriously interested in photography, you’ll
want at least the option of setting exposure (both f-stop and shutter
speed) manually so you can custom-tailor your exposure to the artistic
effect you're trying to achieve.

Selecting Vour Resolution

The best lens can’t produce any more sharpness than the sensor used to
capture its information. For that reason, the resolution of most digital
cameras is the specification most people use to choose their equipment.
They want a 4-megapixel camera or a 5-megapixel model or maybe a 6- to 8-
megapixel camera. They figure (with some justification) that the more pixels
they have, the more features the vendor packs into the camera. After all, you
can expect a 6-megapixel camera to have a decent zoom lens, lots of exposure
control choices, close focusing, and all the other goodies, right?

Most of the time, that’s true. The sensor is usually the most expensive part
of any digital camera, so if you're building a camera that’s going to cost $600
anyway, you might as well load on the other goodies to justify the price.
However, as sensors get less expensive, you'll see cameras with (supposedly)
equivalent sharpness with widely varying feature sets. For example, I've used
cameras in the 6-megapixel range that cost as little as $169 (and had sparse
lists of features to match) and others with the same nominal resolution that
cost $800 and were chock-full of advanced capabilities.

And even when dealing with sensors, all pixels are not created equal. For one
thing, the true resolution of a sensor is likely to be somewhat less than you
might think. Take a sensor measuring 3008 x 2000 pixels. You’d think that
such a sensor could image about 6 million different details. Bzzzt. Wrong
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answer! That would be possible only if the camera were designed to capture
an image only in black and white.

In practice, the sensor has to capture red, green, and blue pixels. With current
sensors, each pixel can capture only one particular color, so those 6 million
pixels are actually divided up into red-sensitive pixels, green-sensitive pixels,
and blue-sensitive pixels. If the pixels were divided up evenly, you’d wind up
with three 2-megapixel sensors — one each for red, green, and blue — rather
than the 60-megapixel sensor you thought you had.

However, the pixels aren’t divvied up in that way. Because our eyes are more
sensitive to green light than to the other colors, sensors typically divide up
their pixels unevenly: 50 percent are green, 25 percent are red, and 25 per-
cent are blue. That’s done by alternating red and green on one line, and
green and blue on the next, as shown in Figure 1-7.

Figure 1-7: The typical sensor pixel is sensitive to red, green,
or blue light.

Your camera’s brain examines the picture and calculates (or interpolates)
what the red and blue values probably are for each green-sensitive pixel posi-
tion, what the green and blue values are for each red-sensitive pixel position,
and the likely green and red values for each blue-sensitive pixel.

Other digital cameras use technologies that are a little different — or a lot dif-
ferent. For example, Sony offers a sensor that captures what it calls RGB+E (for
emerald) light, producing what it describes as color fidelity that is closer to
human color perception, with more life-like rendering of blue, blue-green, and
red hues. Another vendor, Foveon, produces a sensor that has separate layers
for red, green, and blue light, as shown in Figure 1-8, so that each pixel is capa-
ble of capturing any color light without interpolation. This sensor has been
used only in a couple digital cameras from Polaroid and Sigma.
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Blue light absorbed
by blue-sensitive layer

Green light absorbed
by green-sensitive layer

Red light absorbed
by red-sensitive layer

Figure 1-8: The Foveon sensor has separate layers for each color of light.

Beyond the capture scheme used, other factors affect sensors. Some sensors
are more sensitive than others, and other factors make a particular sensor
not perform as well as another one with the same number of pixels. For
example, some sensors don’t register some colors well or have pixels that
bright light can easily overwhelm.

When choosing a digital camera, you want to choose one with the resolution
you want. If possible, compare the pictures taken with each camera under
consideration to see whether that resolution is being put to good use.

When it comes to megapixels, you can estimate the resolution you require
with these guidelines:

4+ Low res (short for resolution): If you're shooting pictures intended for
Web display, for online auctions, or for pictures that either won’t be
cropped or enlarged much, you can get by with a lower-resolution
camera in the 4- to 5-megapixel range.

4+ Medium res: If you often need to crop your photos, want to make larger
prints, or need lots of detail, you want at least a 6- to 8-megapixel camera.

4 High res: If you want to extract small portions of an image, make 8-x-10-
inch prints or larger, or do a lot of manipulation in an image editor, you
want a 6- to 12-megapixel (or more) camera.
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Keep in mind that most digital cameras allow shooting in a reduced mode, so
if you own a high-resolution camera, you can still shoot in low resolution to
pack more images on your digital film or to reduce file sizes on your hard
drive. Resizing images is rarely a good idea, even with a good image editing
program, so you usually want to shoot at the resolution you intend for your
finished photo. Resize later, if you want, but keep your full-size version for
printing, just in case.

The mode in which your camera stores the image on your digital film can
affect the final resolution of your image, too. Digital cameras usually store
photos in a compressed, space-saving format known as JPEG (Joint Photo-
graphic Experts Group). The JPEG format offers reduced file sizes by discard-
ing some information. In most cases, a JPEG file is still plenty good, but if you
want to preserve all the quality of your original image, you might want to set
your camera to store in a lossless image format (that is, one that doesn’t dis-
card any image information when compressing the file), such as TIFF, RAW, or
EXIF. You might be able to choose from different JPEG quality levels, too.

Expect these alternate formats to eat up your exposures quickly. One of my
digital cameras can store 200 images on a particular digital film card in JPEG
format but only 150 in RAW and 40 in TIFF. TIFF and RAW also take more time
to store on the film card, too, so they’re not a good choice when you’re
shooting sports or other sequence-type photos.

Some cameras generally label their resolution choices with names such as
Large, Medium, Small; Standard, Fine, Superfine, Ultrafine; and so forth.
These terms can vary from vendor to vendor.

Choosing Your View

Generally, you want what you see to be what you get, but that’s not always the
case with digital cameras. That’s because the viewfinders available are usually
a compromise between what works best and what can economically be pro-
vided at a particular price level. In the digital photography realm, the solution
has long been to provide you with two viewfinders per camera, each with its
own advantages and disadvantages. In a non-SLR camera, you usually find

4 A color LCD screen on the back of the camera, which you can use to
preview and review your electronic images.

4+ An optical viewfinder, which you can peer through to frame and
compose your image. Some digital cameras with large LCDs don’t have
optical viewfinders at all.

Some cameras have two LCDs: one on the back in the traditional location,
and a second one inside the camera and visible through an optical system.
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This variety is an electronic viewfinder or EVF. None of these are ideal for
every type of picture-taking application.

LCD viewfinders

In a non-SLR, the liquid crystal display, usually measuring 1.5-2.5 inches
diagonally, shows an electronic image of the scene as viewed by the sensor.
(Digital SLRs can’t preview images on their LCD because the mirror, shutter,
and other components get in the way of the sensor until the moment of
exposure.) On the one hand, that’s good because you can view more or less
the exact image that will be captured. It’s also not so good because the LCD
screen is likely to be difficult to view, washed out by surrounding light, and
so small that it doesn’t really show what you need to see. Moreover, the
backlit LCD eats up battery power. I've used digital cameras that died after
20 minutes when the LCD had depleted their rechargeable batteries. Luckily,
some digital cameras let you specify that the LCD is turned on only when
composing a picture or only for a few seconds after a picture is taken (so
that you can quickly review the shot).
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Although often not usable in bright daylight, LCDs, such as the one shown in
Figure 1-9, are better in more dimly lit conditions. Some third parties offer
LCD hoods that fit over the back panel of the camera to shield the LCD from
direct illumination. If you mount your camera on a tripod and make sure all
the light is directed on your subject, an LCD is entirely practical for framing,
focusing, and evaluating a digital image (even outdoors, if you use one of
those protective hoods).
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Figure 1-9: LCD screens work fine in dim light.
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As you shop for a digital camera, check out the LCD under a variety of condi-
tions to make sure it passes muster. Here are some things to look for:

4 Brightness controls: Many cameras include a brightness control that
allows you to increase the brightness of the LCD to make it easier to view
in full sunlight, or to decrease the brightness indoors to use less battery
juice. A related factor is whether the LCD automatically “gains up” by
amplifying a dim image to provide a usable view when it’s very dark.

4+ Swivel mount: The LCD doesn’t have to remain fixed rigidly to the back
of the camera. Some swivel and rotate, allowing you to point the camera
in one direction and move the LCD so that you can easily view it at an
angle. (Alternatively, the part of the camera with the lens can swivel
while the part with the LCD remains in place.)

4+ Resolution and size: Ultracompact digital cameras often have tiny LCD
displays, on the order of 1% inches (measured diagonally), and others
have more generous 2.5-inch LCDs. The size of the LCD and the number
of pixels it contains will partially determine how easy it is to preview
your image. Some may have as few as 80,000 pixels; others may have
230,000 pixels or more. Guess which is easier to view!

4+ Display rate: Some digital cameras update their LCD images more
efficiently, so the view is smooth even when the camera or your subject
is moving. Others offer up blurry images or ghost trails that make it diffi-
cult to view images in motion.

4+ Vanishing images: What happens when you press the shutter release?
Does the image instantly freeze as soon as you start to press the button
but before you actually take the picture? If so, what you saw might not
be what you get because your subject matter might have changed in the
time between the initial press and the actual photo. Or, does the LCD go
completely blank, leaving you with no clue about what you’re shooting?
Ideally, the LCD should display a real-time image right up until the
instant before the picture is taken.

4 Accurate viewpoint: Believe it or not, even though an LCD viewfinder’s
display is derived from the same sensor used to make the exposure, the
LCD might not display 100 percent of the sensor’s view. Instead, it might
trim a little off the sides, top, and bottom, and show you 80 to 90 percent
of the actual picture. That’s not good when you’re carefully composing a
photo to make the most of your pixels, particularly with lower-resolution
cameras that don’t have pixels to spare.

4 Real-time corrections: Some cameras have live histograms — graphs
that show the distribution of the tones in the image — that can be
viewed on the LCD and used to correct exposure manually while you
shoot. These are all non-SLR types, of course. With a dSLR, a histogram
is visible only after the exposure.
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4 Accurate rendition: I've found that some LCDs don’t let you evaluate
just how good (or bad) your picture is because they provide an image
that’s more contrasty, or brighter, or with more muted colors than the
actual digital picture. You don’t want to reshoot a picture because you
think it looked bad on the LCD, or worse, make a manual exposure or
other adjustment to correct a defect that appears only on the LCD and
not in the finished photo.

Optical viewfinders

Most of the time, you use an optical viewfinder, which is bright and clear,
uses no power, and lets you compose your image quickly. However, optical
viewfinders have problems of their own, most notably parallax. Parallax is
caused by the difference in viewpoint between your camera’s lens and the
optical viewfinder. They don’t show the same thing.

If the optical viewfinder happens to be mounted directly above the camera
lens, its view will be a little higher than that of the lens itself. This becomes a
problem chiefly when shooting pictures from relatively close distances (3 feet
or less). Such a viewfinder tends to chop off the top of any subject that is close
to the camera. Optical viewfinders usually have a set of visible lines, called
parallax correction lines, which you can use to frame the picture. If you keep the
subject matter below the correction lines, you can avoid chopping off heads.
Of course, you get more of the lower part of your subject than you can view.

Parallax becomes worse when the
optical viewfinder is located above

and to one side of the lens, as shown in
Figure 1-10. In that case, a double set of
parallax correction lines is needed to
help you avoid chopping off both the
top and the side of your subject. Yuck!
Here are some things to look for in opti-
cal viewfinders:

4 Magnification: I get to use dozens of
digital cameras in a year, and one of ,F'
the first things I notice is the differ- |
ence in magnification of the optical
viewfinders. Put the camera up to
your eye, and you might see a tiny
image floating off in the distance,
with the details of your scene barely
discernible. Other cameras provide
a big view that makes it easy to
frame and compose your photo.

Figure 1-10: Parallax correction lines help
you avoid chopping off heads or worse.
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4 Zoom: Believe it or not, some digital cameras with zoom lenses have
optical viewfinders that don’t zoom! Ideally, the image should match the
view of your LCD and lens, but some cameras keep a fixed view and use
indicator marks to show the picture area.

4+ Parallax correction: As | mention earlier, optical viewfinders might not
accurately frame the image when you move in close to your subject. The
position of the viewfinder window can have an effect: If the viewfinder is
directly above the lens, the side-to-side view will be accurate, but you
might cut off the top of your subject if the camera doesn’t provide paral-
lax correction. If the viewfinder is immediately to the side of the lens, your
problems will involve accidentally cutting off the side of your subject.
Some viewfinders are both above the lens and to one side, which can
produce parallax problems in both directions.

4 Accurate viewpoint: As with LCD screens, the optical viewfinder might
not show everything you're framing, with some image area clipped off
the top, bottom, or sides.

4+ Diopter adjustment: Eyeglass wearers might want an optical viewfinder
that offers adjustment for common prescriptions so the camera can be
used without wearing glasses.

4+ Extended eyepoint: The eyepoint is the distance your eye can be from
the viewfinder’s window and still see the entire view. Some viewfinders
mandate pressing your eye up tightly against the window. Others let you
back off a few millimeters, which is handy when you want to be able to
see around the camera to monitor the whole scene (and not just what
appears in the viewfinder) or prefer to wear your glasses while using the
camera (and are thus not able to get close to the window because the
glasses get in the way).

4+ Readouts: What information is available within and around the optical
viewfinder? Some cameras show nothing but the unadorned image.
Others have framing or parallax correction lines or perhaps a faint grid
to help you line up the image. Perhaps some camera status indicators
appear in the viewfinder, too, such as a flash-ready LED, within the field
of view or located just outside the viewfinder window where it can be
detected by the eye.

Electronic viewfinders (EVUFs)

Some affordable cameras are available with hybrid viewfinders that work
like optical viewfinders (that is, you put your eye up to a window to view
your subject) but that use an electronic display to show you the image.
These LCDs are much like the LCDs found on the backs of cameras, but
because they are automatically shielded from extraneous light, they are
much easier to view. Because they form an image by using the signal from
the sensor, when compared with optical viewfinders, they offer a potentially
more accurate and SLR-like picture-taking experience.
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However, poorly designed EVFs can be a pain to use, so you'll want to exam-
ine the view through any camera so equipped before you sink your money
into one. Here are some of the considerations to think about:

4+ Magnification: EVFs can suffer from the same viewfinder magnification
issues as optical viewfinders. Because you’ll be composing and (in some
cases) focusing manually via the internal LCD, make sure your view is as
large and sharp as possible.

4+ Extended eyepoint: Just as with optical viewfinders, you might not be
able to (or want to) press your eyeball up to the viewfinder window, so
an EVF with an extended eyepoint is a plus, particularly with eyeglass
wearers.

4+ Readouts: Compared with optical viewfinders, EVFs usually contain a lot
of information, including status readouts, grids, focus and exposure area
indicators, and so forth, as shown in Figure 1-11. Make sure you can turn
off these distracting elements when you don’t want to see them.

Figure 1-11: Electronic viewfinders can contain a lot of
distracting information.

4+ Swivel mount: Some eyepieces for EVFs can swivel 90 degrees to allow
taking pictures from especially low or high angles. I find this capability
handy when I have the camera mounted on a tripod at about waist level
and [ don’t want to crouch down to look through the viewfinder.

4+ Resolution and size: The LCDs in EVFs typically have more detail than
their camera-back counterparts. Vendors have raised the bar on EVF
resolution, with at least one offering a full megapixel display on its
top-of-the-line camera. These high-resolution electronic viewfinders are
easier to see to discern detail and more reliable when used for focusing.
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4+ Display rate: EVFs can have ghost images, too. A brand-new feature on
some models is so-called smooth mode, which refreshes the EVF image
60 times a second (about twice as fast as normal), providing an espe-
cially good preview of your photo.

4 Vanishing images: Obviously, the EVF can’t provide a continuous image
because the sensor’s view must be collected and captured at the instant
the photo is taken. During that interval, the image might freeze onscreen
or vanish entirely. Some cameras switch into high-gain mode under dim
lighting conditions, in which the image signal is amplified to provide
better viewing, sometimes offering only a fuzzy or black-and-white view
in that mode. Better cameras give you an accurate, full-color preview up
until the exact moment the photograph is taken.

4 Accurate viewpoint: EVFs don’t always display 100 percent of the
sensor’s view, either. The best show at least 92-99 percent of the actual
picture area in the viewfinder.

4 Accurate rendition: As with any LCD, the image you see might not be
exactly like your final photograph, but the results should be close.

SLR viewlfinders

And there’s always the single-lens reflex (SLR) camera, which shows you
(more or less) the exact image the sensor sees through the lens via an
optical system. It’s done with mirrors (really). In the most common config-
uration, you view the subject through the lens by using an image bounced
off mirrors and (sometimes) a glass prism. When you take the picture, the
mirror moves out of the way to expose the sensor. You lose sight of the
image for a fraction of a second, but film SLR users have been tolerating that
inconvenience for decades.

Both general types of SLR viewfinders use a mirror to bounce light upward,
where it then reflects off a series of surfaces until the final image (erect and
nonreversed from left-to-right) is viewed through an optical window. Less-
expensive cameras use a series of mirrors (often called a pentamirror
because of the five total surfaces in the structure), and more costly models
use a solid glass prism, called a pentaprism. The latter provides a brighter,
higher-contrast image that looks better and is easier to use for viewing and
focusing. However, pentamirror viewfinders can also be very good, particu-
larly if you don’t compare them directly with models using a pentaprism.
The light path for an image viewed by a pentamirror/pentaprism viewing
system is shown in Book IIl, Chapter 1.

&'N\BER Regardless of what optical or SLR viewing system you use, if you wear

Y glasses and want to shoot without them, you want to make sure your camera
either has built-in eyesight (diopter) correction to adjust for your near/
far-sightedness or can be fitted with corrective lenses matched to your pre-
scription. This vision correction enables you to get your eye close enough to
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the viewfinder to see the whole image. Some viewfinders make it difficult for
those wearing glasses to see through the optical system because a bezel or
other part of the viewfinder prevents the glasses from getting close enough.

Considering Your Storage Options

The kind of storage your digital dream camera uses will never be a factor in
making your selection (unless it’s a truly odious choice, and that’s a matter
of personal taste). The days of the digital cameras that used floppy disks and
other oddball media are long gone. Today, all digital cameras use one (or
more) of the following options:

4+ Secure Digital (SD): Among non-SLR cameras, the SD format is by far the
most popular memory card format. These postage-stamp-size cards,
which allow manufacturers to design smaller cameras, are available in
roughly the same capacities as CompactFlash, and cost about the same.
The chief drawback (to date) is that there are no mini hard drives in the
SD format. If you want to use a mini hard drive, you need a camera with
a CompactFlash slot. Some digital cameras can also use the similar (but
slower) MultiMediaCard (MMC).

4+ CompactFlash (CF): CompactFlash is the second-most-favored format in
the United States. Although physically larger than SD, CompactFlash
cards are still very small and convenient to carry and use. As larger
capacities are introduced, they usually appear in CF format first. As a
bonus, the CompactFlash slot can also be used for mini hard drives,
such as those from IBM, with capacities of a gigabyte or more. They are
the most popular memory card format for digital SLRs.

4+ xD and mini-xD: The xD and mini-xD formats are new, smaller than Secure
Digital, and supported by fewer vendors (currently only Olympus and
Fuji). Although it’s wise to avoid getting stuck using a Betamax format
when everyone else has converted to VHS, you're safe in choosing a
camera using an xD variant. The vendors are important enough that even
if the format eventually fails, you should be able to purchase memory
cards for as long as your camera works. Indeed, because memory cards
are typically used over and over forever, the cards you purchase with your
camera or shortly thereafter are likely to serve you throughout your
camera’s useful life.

4+ Sony Memory Stick: About the size of a stick of gum, Sony’s Memory
Sticks are useful because you can also use them with other devices, such
as MP3 players. They’re not going to replace CompactFlash, though. Sony
has had an unfortunate tendency to flip around among memory choices
for its digital camera, and didn’t stop when the Memory Stick was intro-
duced. It’s now available in Memory Stick (up to 128MB sizes), Memory
Stick Pro (larger capacities), Memory Stick Duo (a smaller version that
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108  No Flash in the Pan: Determining Your Lighting Needs

needs an adapter to fit memory card readers outfitted for Memory Sticks),
and, most recently, Memory Stick Pro Duo (in capacities up to 4GB).
Whew!

4 Mini hard drives: For a long time, mini hard drives were your only
option when you needed more than a gigabyte of storage. If you're using
a 6-megapixel or better camera and like to save your images as TIFF files
or in another lossless format, you need more than a gigabyte of storage.
However, with CompactFlash cards now available in 4-8GB sizes, the
mini hard drive is losing its capacity edge, and it has always cost more
than the equivalent silicon memory card. Although not excessively
prone to failure, mini hard drives do have moving parts and must be
handled with more care than memory cards.

4+ CD-R/RW: Sony, in its never-ending quest to change its digital camera
media options annually, actually tried out both floppy disks and mini
CD-R and CD-RW discs for its digital cameras. Although not really a bad
idea, because the media is relatively inexpensive (a 240MB mini CD-R is
a lot cheaper than a 256MB CompactFlash card), this option never
caught on because digital camera memory requirements eventually
exceeded the capacity of mini CDs. Sony seems to have settled into an
ever-changing Memory Stick groove now.

Digital memory cards might be offered in various speeds, such as standard,
high-speed, 40X, Ultra, and Extreme, depending on the nomenclature used by
the vendor. The faster, more expensive media are able to store images more
quickly. Unless you're shooting sequences and don’t want to wait even a
short time between pictures, standard media will probably do the job for
you. Some newer digital cameras that provide a high-speed burst-photo mode
require these higher-performance digital cards to function as advertised,
however. With memory cards now being offered in 133X and 150X speeds,
there’s no telling where the speed race will end.

No Flash in the Pan: Determining Your Lighting Needs

Your digital dream camera’s electronic flash capabilities (or lack of them)
should be on your list of things to evaluate before you make a purchase deci-
sion. Not every photo is possible using existing light. Even if there is plenty of
light, you might still want to fill in those inky shadows with an electronic flash.
Your camera’s built-in flash features are definitely something to consider.

Most digital cameras have a built-in flash unit that can be turned on or flipped
up or swung out or otherwise activated when you want to use a flash — or
when the camera decides for you that the flash is required. (Usually, a tip-off is
a flashing red light in your viewfinder or next to it. Time to flip up that flash!)
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You should be aware that most flash units are good only over a particular
range. If you've ever seen a fan stand up in the balcony at a Bruce Springsteen
concert and take a flash picture of the Boss from 100 feet away, you’ll under-
stand just how limited flash is at long distances. Some units are so feeble that
they can only illuminate subjects 2 to 12 feet away. Others have special set-
tings to spread the flash illumination for wide-angle shots or tighten it up for
telephoto pictures.

Here are some features to look for in an electronic flash:

4+ Auto-on: It’s useful to have a flash that can be set to flash only when it’s
needed. Some cameras require you to flip up the flash to use it. Others
build the flash into the body of the camera in such a way that the flash
can be used anytime.

4 Autoexposure: An electronic flash can sense the amount of light reflected
back from the subject and turn itself off when the exposure is sufficient.

4+ Red-eye prevention: Some flashes can be set to produce a short preflash
just before the picture is taken. That causes the subjects’ irises to con-
tract, reducing the possibility of the dreaded red-eye effect. Alternatively,
the preflash can fool your subjects into thinking that their ordeal is over
and produce some priceless weird expressions.

4+ External flash capabilities: At
times, you want to use an external
flash, either in concert with or
instead of your camera’s built-in
flash. See whether your camera
has either a built-in flash-sync
socket or a hot shoe that you can
use to mount an external flash and
connect the camera to the flash.
Keep in mind that many digital
cameras require that you use only
a particular brand of flash to retain
the automated exposure features
or (in some cases) to avoid frying
your camera’s flash triggering cir-
cuit with too much voltage. If
you're thinking of using a slave
sensor to trigger the flash, make
sure that it can be used with your
camera. The preflash of some cam-
eras will set off the slave unit. Figure 1-12: External flash units add
Figure 1-12 shows an external flash  power and flexibility to your lighting
unit fitted with a diffusing dome to  repertoire.
soften the illumination.
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A Dozen Exotic Digital Camera Features

After automobile manufacturers introduced heated seats and the Global
Positioning System (GPS) for their luxury cars, everyone wanted them, so the
designers had to come up with other high-end features, like holographic
rearview mirrors and rocket-powered ejection seats. Digital camera vendors
are in a similar race to develop features that are similarly too-cool-for-school.
(Believe it or not, some high-end cameras can use GPS to record the camera’s
current geographical location when each picture is taken!) Here are some of
my favorite features that are exotic now but probably won’t be exotic by the
time you purchase your next camera:

4 Sound-activated self-timers: | had a ball playing with a new camera that
could be triggered by sound. Just set the audio sensitivity, go get in the
picture yourself, and shout, “Cheese!” No more racing to beat the self
timer or ending up with a photo showing you holding your camera’s
infrared (IR) remote control.

4+ Ultra-fast shutter speeds: At least one camera has a shutter speed of
1/16,000 of a second. You might need a supernova as your illumination
source, but you can stop the fastest action with this baby.

4 Image stabilizers: Several cameras offer internal stabilization that cancels
the effects of shaky hands or the blur induced by the high magnification
of a telephoto lens. My favorite is the camera that automatically moves
the sensor in time with your camera jiggles.

4+ Night shot capabilities: Digital camera sensors are inherently sensitive
to IR illumination, so vendors like Sony provide enhanced night photo-
graphy capabilities by taking advantage of this sensitivity.

4+ Infrared photography: Many cameras have a device called a hot mirror
to filter out infrared light but allow flipping this filter out of the way or
leaving enough remaining IR sensitivity to allow you to take interesting
weird-tonal infrared pictures.

4+ Predictive focus: Slow autofocus is the bane of digital cameras, which is
why [ was glad to see the introduction of high-end models smart enough
to figure out where focus should be set ahead of time when you’re photo-
graphing subjects for which the focus changes rapidly.

4+ Enhanced movies: Traditionally, digital cameras have been able to
shoot only short video clips (perhaps 15-30 seconds) at abysmal resolu-
tions (some no better than 320 x 240 pixels) and not necessarily with
sound. That’s changing with the latest crop. Some recent digital cameras
are virtual camcorders, letting you grab VHS-quality clips for as long as
your digital memory card holds out. Make sure your card is a capacious
one because digital video can eat up a megabyte a second!
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4 Unlimited burst mode: I loved using an advanced digital camera that uses
a technique called pipelining to keep the images flowing onto the memory
card at high speed (when used with a high-speed card). I managed to take
more than 150 3.3-megapixel resolution photos in a row at around 4 frames
per second (fps) before my 256MB memory card filled up. Set to a lower
resolution, I took 1,500 shots in a little more than five minutes. My finger
got tired before this ultra-fast camera started slowing down. Think how
well you can analyze your golf swing with a camera like this!

4+ Panorama photography: A growing number of digital cameras have cool
panorama capabilities that make it easy to shoot a series of pictures that
can be automatically stitched together in your computer. You find out
more about panorama photography in Book IV, Chapter 6.

4+ Two-in-one shot: Don’t have a tripod but want to get in the photo
yourself? Some cameras let you take a picture of the background,
have someone else take a picture of you, and then merge the two shots
automatically.

4+ Underwater photography: [ once purchased a Nikonos underwater film
camera specifically so I could take surfing photos at Huntington Beach,
California. (I wasn’t surfing; I was photographing surfers.) Now, anyone
with a digital camera and an inexpensive underwater housing offered for
Canon and other models can take pictures in, around, and under the sea.
Digital cameras are much better than my old Nikonos: You get to see
exactly what you shot right away, so you can jump back in and do it over
until you get it right.

4+ Time-lapse photography: Thirty or forty years ago, the big thing was
time-lapse photos of flowers opening and paint drying. Today, every tele-
vision show includes a sunset-to-sunrise time-lapse sequence to demon-
strate that time marches on. Whether you have some flowers you want
to watch opening or you need to document a construction project, digi-
tal cameras with time-lapse capabilities can snap off a picture every few
seconds or every few hours, depending on how you set them. This is a
great feature that’s fun to play with.

Checking Out Ease of Use

WMBER
@ﬁ
&

I've saved the most important topic for last because I want it to sink firmly
into your mind as you put this book down and continue to think about what
you're looking for in a digital camera. Usability is one of the most important
factors to keep in mind when choosing a camera. The sharpest lens, the
most sophisticated sensor, and the most advanced features are all useless
if you can’t figure out how to operate the stupid camera! I've owned digital
cameras that absolutely could not be used without having the manual at
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hand. Even common features were so hard to access that I sometimes
avoided taking certain kinds of pictures because activating the feature took
too long.

Ease of use is not limited to digital cameras, of course. Difficult-to-operate
cameras have been creeping up for 15 or 20 years. This was not always so.
When I began my photographic career as a newspaper photographer, film
cameras had a limited number of controls. There was a shutter speed dial,
f-stops to set on the lens, focusing, and maybe a rewind knob to move the
film back into the cassette when the roll was finished. Over the years, elec-
tronic exposure controls were joined by exposure modes and a ton of other
features as film cameras became more and more computer-like.

Today, even digital cameras that most resemble their film counterparts bris-
tle with buttons, command dials, mode controls, menus, and icons. That’s
not necessarily a bad thing. What is evil is an interface that’s so convoluted
that even advanced users might have problems. You might have to wade
through nested menus to change the autofocus or exposure control mode.
Switching from aperture-priority to shutter-priority can be a pain. Something
as simple as changing from automatic focus to manual focus can be difficult,
particularly if you don’t make the switch very often and forget which combi-
nation of buttons to press.

Ease of use varies greatly, depending on which sets of features are most
important to you. A camera that one person might find a breeze to use might
be impossible for another person to manage simply because a particular
must-have feature is hard to access.

[ urge you to try out any digital camera that you're seriously considering
buying before you plunk down your money. A camera’s feature set, the
vendor’s reputation, or recommendations of a friend won'’t tell you how the
camera will work for you. Hold the camera in your hand. Make sure it feels
right — that its weight and heft are comfortable to you. Be certain your
fingers aren’t too large or too small to handle the controls. Can you see
through the viewfinder?

If possible, take the camera for a test drive, borrow a similar camera from a
friend or colleague, or at least shoot some photos in the store. Can you find
the features you use most? Can you figure out the menus and buttons? Is the
camera rugged enough to hold up under the kind of treatment you'’ll subject
it to?

As much as I like buying by mail order or over the Internet, a digital camera is
too personal a tool to buy from specifications lists and photos. If you're read-
ing this book, you’re probably serious enough about digital photography that
you’ll be spending a lot of time with your camera — and probably will spend
more than you expected to get the camera you really want. Make sure it really
is the one you want by giving it a thorough workout.



Chapter 2: Setting Up a Computer
for Digital Photography

In This Chapter

1~ Choosing between a Mac and a PC

1+ Understanding your memory and storage needs
1~ Selecting a microprocessor

1 Doubling your display pleasure

1+~ Pointing with a pen

ou might be ready for digital photography, but is your computer up to
the task? The good news is that virtually any computer of recent vintage
probably has the horsepower and features you need to work with the
digital images that you capture with a camera or scanner.

Even so, the differences between a computer that’s
good and one that’s good enough can be significant.
Your system might be exceptional, or it might be the
exception. You probably don’t want to work with
the minimal system possible even if you'd rather
invest your money in a better digital camera. (I
know, if faced with the choice of a new, superfast
computer and a digital single lens reflex, I'd
choose the camera every time.)

This chapter helps you develop your own checklist
of recommended hardware, shows you how to upgrade
to make your work even easier, and offers tips on setting
up your computer to make working with digital images a
breeze.

In this chapter, I cover only the main equipment options for setting up a com-
puter for digital photography editing and storage. You can find information on
equipment used to transfer images between your camera and computer in
Book I, Chapter 3.
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Hardware Wars Revisited

Macs versus PCs. Why are we even having this conversation?

Well, it wasn’t my idea. Then Steve Jobs and his crew decided to abandon
the IBM microprocessors that have been inside every recent Macintosh and
replace them with something called a “dual core” chip from Intel. The new
Intel-based Macs are faster, still sexy, and have aroused the interest of even
dedicated Windows PC operators. Anyone weary of the weekly “critical
security flaw updates” that plague Windows computers or who covets the
stylish and common-sense design of the Mac is now taking a serious look at
the computer arena’s “other” platform. That’s become especially true with
the introduction of the Macintosh Boot Camp software, which lets you install
Microsoft Windows XP on the new Intel-based Macs and boot either operat-
ing system.

Of course, digital photography, graphics work in general, and multimedia
production were the key arenas in which the Macintosh versus PC battle
never died out. In most other areas, Windows-based systems have taken
over the desktop, with Macs relegated to specialized or oddball applications.
Apple keeps coming up with compelling hardware, interesting computer
designs, and lots of quirky but cool applications (Garage Band, anyone?), but
those computer troops solidly camped in the Windows realm usually take
notice of what’s going on only when those cute Macintosh commercials
interrupt prime-time TV.

Not so in the digital photography world. Visit any newspaper or magazine
that relies on digital cameras, and you’ll find Macs. Drop in to any profes-
sional digital photographer’s studio, and you’ll see a brawny Macintosh
perched on the desktop. Talk to the top Photoshop users in the country:.
Most of them are using Macintoshes, too, either exclusively or in tandem
with a Windows box.

Indeed, for a long time the only logical choice for most photographers has
been the Macintosh. The decision was along the lines of selecting a 35mm
Nikon or Canon SLR for photojournalism or a Sinar view camera for studio
work: a no-brainer. Although I don’t have hard figures, my gut feeling is that
Macs outnumber PCs in many imaging production environments by at least
8 to 1. In the rest of the business world, the figures are reversed, except on
television, where anyone shown with a laptop computer is always using an
Apple PowerBook.

By and large, the latest Macintoshes provide enough muscle for virtually any
still-image work, particularly when equipped with dual processor chips (which
provide extra speed with applications designed to work with multiple CPUs)
and gigabytes of memory. No photographer need be ashamed of driving a
properly equipped Mac.
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In the digital photography world, Macs are not only viable but are often the
system of choice. However, in some cases, you might not have a choice —
maybe you already own a computer or need to use a particular system to
remain compatible with friends and colleagues.

Yet, if you aren’t locked into a particular platform and operating system,
should you be using a Macintosh or a Windows computer? If you want a
definitive answer, I'd say, “It depends.” (Which isn’t very definitive, is it?)
Each platform has its pros and cons. Here is a summary of some of the
things you should consider:

4+ The bandwagon effect: If you plan to make your living (at least in part)
from digital photography, you need to learn two things: how to use a
Mac and how to perform image magic with Photoshop. Both skills are
expected to be part of your résumé. Jump on the bandwagon while you
can. On the other hand, Windows proficiency is expected for most jobs
outside imaging. Unless you're a full-time graphics professional, you
might have to learn to wear two hats.

4+ Ease of use: The Macintosh is generally acknowledged to be a bit easier
to learn and somewhat easier to use for many tasks. Of course, the
Macintosh system’s vaunted ease of use has been subverted over the
years as Apple has tried to catch up with Windows systems. (For exam-
ple, if you want to stick with the Mac’s sublimely simple single-button
mouse, you must augment it by holding down the Control key while
clicking to reproduce the Windows two-button mouse’s right-click
option. You can also reprogram certain Macintosh mice to provide the
same results.) If you're just starting out in computing and don’t want to
climb a steep learning curve, the Mac is your computer.

4+ Software compatibility: Not all applications are available for both Mac
and PC. Most key applications are offered for both, including the
Photoshop CS2 image editor, shown in Figure 2-1 in both Mac and
Windows incarnations; the Stufflt archiving tool; browsers such as
Netscape and Internet Explorer; and word processing applications such
as Microsoft Word. Plus, Microsoft is now offering Virtual PC for the
Macintosh, making it possible to run Windows XP and Windows appli-
cations under Mac OS X on many different Macs. Boot Camp does the
same thing for the latest Intel-based Macintosh models. But if you must
be totally compatible with Windows, you still need Windows.

4+ The cost factor: Macs have generally been more expensive than PCs,
although the cost difference has decreased over the years. Even so, with
powerful Pentium systems available in barebones configurations for
$500 or so, even the least expensive Mac capable of image editing still
costs a bit more. In the Mac’s favor, however, most peripherals and add-
ons, such as memory, hard drives, DVD devices, monitors, and so forth,
cost the same whether you’re purchasing them for a Mac or a PC.
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Figure 2-1: Photoshop looks the same on PCs and Macs.
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4+ Hardware reliability: Reliability is a double-edged sword. Macs are won-
derfully crafted machines, a beauty to behold when you dismantle one,
and filled with high-quality components. The insides of some of the
assembly-line-built PCs have a decidedly industrial look, and if you
examine the parts, you might find a mixture of known brand-name pieces
and what’s this? components. On the other hand, if something does break
on your PC, you can run down to the local MegaMart and buy a new
floppy drive, a CD burner, and maybe some memory off the shelf next to
the cell phone batteries. My local grocery store carries these items. Macs
also use many off-the-shelf components, but some specialized parts for
your Mac might be harder to come by, and it’s unlikely you’ll know how
to replace them anyway. So, even assuming the Mac is more reliable than

the average PC, is that always an advantage? Bookll

Chapter 2
4 Operating system reliability: Trust me, Macs do crash, especially when
Apple is making a transition, as it did from Mac OS 9.x to OS X or from
the current version of OS X to the next one. Early versions of a Mac OS
can crash and burn as spectacularly as any Windows release. On the
other hand, Mac users don’t add hardware or new applications at the
same clip as Windows users, who seem to be constantly trying this new
utility or that, applying the monthly patches Microsoft issues for its soft-

ware and OS, and doing other fiddling that can lead directly to the Blue
Screen of Death (BSOD).

Anyone who swears his or her Windows installation never crashes is
probably using Windows XP, never runs more than two or three applica-
tions at once, and avoids installing new software more often than once
every six months. 'm an exception to that rule: I haven’t had a crash in
more than a year. That’s when I uninstalled XP Service Pack 2 and
stopped applying Microsoft’s monthly patches. The secret is that none
of the updates in the past year fixed any operating flaws in Windows XP;
they were all repairs for security defects. As long as [ hide behind my
firewall, don’t use Internet Explorer, and am careful about what Web
sites [ visit, I'm able to run my antique installation of Windows with no
crashes. Still, if avoiding crashes is on your holiday gift list, the Mac still
has the edge. This may eventually change as Apple completes the transi-
tion to Intel processors, and virus-happy hackers turn their attention to
producing viruses and ill-behaved applications that exploit the weak-
nesses that exist in Mac OS.
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4+ Technological superiority and coolness: If owning a computer that
looks like a Tensor lamp or is built into an LCD screen is your cup of tea,
and you like the idea of having cool stuff before anyone else, you really,
really need a Macintosh. The most exotic hard drive interfaces (from
SCSI in the '80s to FireWire in the '90s) came to the Mac first, along with
flat-panel displays, DVD burners, and other radical innovations that
turned out to be a little (or a lot) before their time.
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Hardware differences aside, the most visible differences between Macs and
PCs (after you get past transparent, multicolored cases and eye-catching
design tricks) stem from the two competing operating systems. A few years
ago, a dual-barbed joke was circulating, implying that the current version of
Windows was almost identical to the Macintosh operating system of 1984.
But of course, the same observer noted, the current Mac OS was also almost
identical to the Macintosh operating system of 1984. The more things
change, the more they stay the same.

The gibe is no longer true. Windows has been transformed into Windows XP,
which is the most stable, easiest-to-use operating system Microsoft has ever
offered, even if it does still resemble some of the older versions of Mac OS. At
the same time, Mac OS is completely different, too. Mac OS X is now a thinly
disguised version of Unix, which is both good news and bad news. Unix is more
stable than the OS 9.x and earlier versions that preceded it, but Mac-Unix has
some underlying complexities (including — horror of horrors — a command
line interface if you want it) that didn’t intrude themselves on Macintosh
users in the past.

Windows has its advantages and disadvantages. One advantage is that it’s
almost universally available and has the broadest range of widely used appli-
cations written for it. One disadvantage is that Windows still forces you to
do things the Microsoft way when you’d really rather do them your own way.
For example, Windows XP is fond of setting up your network the way it likes,
bludgeons you into using Internet Explorer even if you prefer Firefox, Opera,
or Netscape, and has a tendency to coerce you into using the Windows
Media Player for everything and anything.

Mac OS, on the other hand, lets you do things your own way quite easily.
Would you prefer that your digital camera application be installed on your
secondary hard drive rather than the one you first installed it on? Just drag
it to the new hard drive; there’s no need to uninstall it and reinstall it as you
must do with Windows.

Although you probably won’t choose a computer based on the operating
system, these things are nice to know.

What Equipment Do Vou Need?

Digital cameras themselves make few demands on a computer system, of
course. The real drain on your system is running your image editing program
and storing your images for editing or archival purposes. Make no mistake,
image editing is among the most demanding types of work you can lay on a
computer, so before you start down this road, you’ll want to know about the
minefields that lie along the way. If you want the flying short-course, the ten
most important things you’ll need to consider are
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Memory

More memory

Even more memory

Adequate local storage (a fast, big hard drive. Or two.)

A fast microprocessor

Archival storage

Advanced video display capabilities (maybe two monitors)

Other peripherals, such as digitizing tablet and pen devices

PR R R R R R R

A little more memory

+

More RAM than you thought you’d ever need

The rest of this chapter examines each of these needs thoroughly.

Determining How Much Memory You Need
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If you noticed that I listed memory five times in the preceding top ten list,
there’s a reason for that. Memory makes everything else possible. A fast, big
hard drive is also important because it gives you room to work with your
current project’s files and can substitute for RAM (memory) when you finally
do run out. But nothing can replace memory when decent performance is
your goal.

You can finish reading the rest of this section if you want to know the hows,
whys, and how muches of memory, but [ can give you a two-word recommen-
dation that will let you skip ahead, if you want:

Two gigabytes!

That much RAM will cost you very little, perhaps a couple hundred dollars;
it’s the most RAM the current version of Photoshop can use; and it will solve
most of your problems. We now continue with the technical portion of our
program (for those of you who aren’t skipping ahead).

[ can’t emphasize this point enough: When you’re working with images, you
must have, as a bare minimum, at least six to ten times as much RAM as the
largest image file you plan to work with on a regular basis. With inexpensive
8-megapixel cameras now available for a few hundred dollars, many digital
photos in their native RAW format can be huge, requiring 180-600MB of RAM
for each image you want open at once. If you're working with more reason-
ably sized 4MB images but need to have ten of them open at one time, you
still need tons of memory to do the job.
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Without sufficient RAM, all the bucks you spend on a super-speedy micro-
processor are totally wasted. Your other heavy-duty hardware is going to
come to a screeching halt every time you scroll, apply a filter, or perform
any of a number of simple functions. That’s because without enough RAM to
keep the entire image in memory at once — plus your image editor’s Undo
files (basically copies of the image in its most recent states) — your com-
puter is forced to write some or all of the image to your hard drive to make
room for the next portion it needs to work with.

Digital photography can produce some large images, too, especially if you're
working with a serious camera in the 8- to 12-megapixel range and choose to
save your files in the highest-quality mode. An 18MB image is fairly common
these days, so you should be prepared with as much RAM as you can cram
into your computer.

Most systems have two to four memory slots, which can each hold a
256-1024MB memory stick. Loading your computer with 2GB of memory is
not at all outlandish and is relatively inexpensive. You can purchase that
much memory for a few hundred dollars. Any Mac or PC with 512MB or less
of RAM is hopelessly under-equipped for digital photography. Beefing up
your memory can be the least expensive and most dramatic speed enhance-
ment you can make.

Indeed, a few years ago, when I upgraded from my ancient 800 MHz Windows
computer to a spiffy new 2.8 GHz Pentium 4 model, | was annoyed to find that
my new computer seemed to be significantly slower than my old one. It didn’t
take long to discover the reason. My older computer had 2GB of RAM, but my
new “faster” one was initially equipped with a mere 512MB of memory. When
[ worked with large digital photos, Photoshop didn’t have enough RAM to
keep more than one or two images in memory at one time. It was forced to
continually swap image information out to the hard drive to make room for
the changes [ made. Having a processor that was more than three times faster
made no difference: Lack of memory was slowing everything down through a
poky hard-drive bottleneck.

Within a week, I upgraded the Pentium system to 2GB of RAM, and guess
what? It really flew! If you feel your current computer is slow, try adding
memory before upgrading to a faster processor. You might be surprised. With
any luck, an upcoming version of Photoshop will be able to use more than 2GB
of RAM, and we’ll get even better performance. (With real luck, that version
will be available when you're reading this!)

Choosing Local Storage

Your graphics powerhouse is only as fast as its narrowest bottleneck, so
you should pay special attention to that looming potential roadblock I just
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mentioned: your mass storage subsystems. You need one or more big hard
drives for several reasons:

4+ To keep as many images as possible available for near-instant access:
A large hard drive enables you to store all your current projects — plus
many from recent months — all in one place for quick reference or
reuse. With a large hard drive, you can store a vast library of your own
photographic clip art, too, and avoid having to sort through stacks of
archive CDs.

4+ To provide working space for your current projects: You'll want scratch
space — space on your hard drive — to store images that you probably
won’t need but want to have on hand just in case. Alternate versions of
images eat up more space as you refine your project. Image editors such
as Photoshop also need spare hard drive space to keep multiple copies
of each image you’re editing.

4+ To let you store additional applications: Good bets here would be
panorama-generating programs, a second or third image editor for spe-
cialized needs, utility programs, extra plug-in programs, and so forth.

In the recent past, your hard drive storage options were limited to internal
hard drives in one of two categories: fast, expensive hard drives using a
Small Computer System Interface (SCSI; SKUZ-zee); or inexpensive, slow hard
drives using the Enhanced Integrated Drive Electronics (EIDE) interface or
ATA (Advanced Technology Attachment). Today, the technologies have con-
verged. SCSI drives no longer cost that much more than ATA disks, but they
are now used only for specialized applications, such as file servers, where
the SCSI interface’s ability to address many drives simultaneously comes in
handy. Fortunately, ATA drives have gotten much, much faster. Moreover,
new options have appeared, chiefly in the form of external hard drives that
link to your computer via FireWire or Universal Serial Bus (USB) and a new
kind of internal drive called Serial ATA (or SATA.)

SCSI and EIDE hard drives

You don’t see SCSI disks used much outside server environments these days.
Their chief advantage is that your computer can transfer information to and
from several SCSI disks simultaneously. That’s because SCSI is a system-level
interface that conveys information in logical terms: Multiple devices can use
the same connection in parallel fashion, although more intelligence is
required to decode requests from the computer. Other kinds of hard drives,
particularly EIDE/ATA drives, might have to take turns talking to your com-
puter, which can reduce performance. Peripherals are so fast these days that
the difference in performance between SCSI and other systems is seldom
important outside the server farm.

The chief advantage of drives in the EIDE/SuperATA and the very latest serial
ATA (SATA) categories is that they are almost free. As [ was writing this book,
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even mammoth 500GB hard drives could be purchased for a lot less than

50 cents per gigabyte, and I expect the cost per byte will drop even more
dramatically during the life of this book as the latest 750GB and larger disks
become standard. However, even at 50 cents per gigabyte, hard drives aren’t
that much more expensive than CD-R media.

External hard drives

With external hard drives, you're no longer limited to the number of disk
drives you can cram into your computer’s housing. These disks link to your
computer using an IEEE 1394 (FireWire) or USB 2.0 interface, such as the one
shown in Figure 2-2.

Figure 2-2: This drive uses slide-out trays to allow hot-swapping one disk drive for another.

The advantage of external storage is that you can install and remove FireWire
and USB 2.0 drives without opening your computer’s tower, and you don’t
need to worry about how to fit them in the case. You can also easily move
such an external drive from computer to computer.

Archiving and Backing Up

Digital photos can fill even the largest hard drive faster than Yankee
Stadium on Bat Day. Your graphics powerhouse needs open-ended storage
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that is relatively cheap and reliable and that provides near-online (perma-
nent storage) access speeds.

Zip disks (R.LP.)

I mention Zip disks because they eventually became a part of popular cul-
ture, almost turned into a generic term, and threatened to replace the floppy
disk before $40 CD and DVD burners killed them off. Today, you see Zip disks
only in old spy movies in which a secret agent copies crucial data while a
bar graph on the computer display shows the progress. Today, solid state
“thumb” or “jump” drives do the same thing more cheaply and plug right
into your USB port. (The latest spy movies show the agents using a thumb
drive, but the bar graph remains maddeningly slow because the need for sus-
pense hasn’t been eliminated by the pace of technology.)

CD-Rs and CD-RWs

CD-R and CD-RW discs have a bit more credibility in this arena because you
can cram a healthy 700MB on a CD that can cost as little as a nickel. You still
wouldn’t want to back up your 160GB drive to 200 CD-RW discs (even though
the media itself might cost you only $20), but it’s entirely practical to archive
your digital photos on this media if you are using a camera with no more
than 5 or 6 megapixels of resolution. For cameras that produce larger files,
even CDs don’t have much capacity.

DUDs

DVDs have become a more viable long-term storage medium, even though
the basic one-layer DVD barely holds the contents of a 4GB memory card.
(And those of us with higher-resolution cameras can fill up a 4GB card very
quickly; on a recent trip I snapped roughly 4GB of photos every day for ten
days running.) Depending on how many layers are used, DVDs can store up
to 8GB or more each. The cost of DVD burners is coming down, and this
medium should become more popular when the industry settles on a single,
standard format. In a world with DVD-ROM, DVD-RAM, DVD+RW, and DVD-
RW, the best plan is to buy a DVD burner that supports them all. Things
might become more complicated in the future when the newer, extra-high
capacity DVDs (including the blue-laser Blu-ray discs) become available.

Book I
Chapter 2

Aydesbojoyq
|enbiq 10} 19)ndwon
e dn bumag

Avoiding Microprocessor No-brainers

The fastest microprocessor might not be absolutely essential for image edit-
ing if you're using a digital camera with about 5 megapixels of resolution.

Higher resolutions call for more horsepower, however, and if you're buying a
new machine, there’s no reason not to buy one with the fastest microproces-
sor available, within reason. The microprocessor is what processes many of
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your program instructions — everything that isn’t handled by a separate dig-
ital signal processing chip. So the faster the microprocessor runs, the faster
your image editing software will work, generally speaking.

Each individual element of an image involves from 1 to 4 or more bytes of
information. An RGB (red/green/blue) image requires 3 bytes per pixel, a
CMYK (cyan/magenta/yellow/black) image needs 4, and additional alpha
(selection) channels take up 1 byte each. Even a relatively minuscule 640 x
480, 24-bit image can involve nearly 1MB of data.

If you ask your image editor to apply an image-processing filter to an entire
image, your microprocessor must calculate the effects of that filter on each and
every one of those million bytes. That can take a second or two with a very fast
system or as long as a minute or much more with very slow computers.

And although there are other constraints (such as memory or hard drive
speed), the speed of the microprocessor affects nearly everything you do on
your system. As you might guess, a fast CPU should be a major considera-
tion when assembling a graphics workstation from scratch. You might not
need the fastest microprocessor available, but then again, you never hear
anyone complaining that a computer is just too darn fast.

Determining What's Most Important
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Even though [ went three years between new computers, [ generally buy a
new system more often than that, and upgrade most other components more
frequently than that. However, | keep three pieces of equipment for years
and years. I lavish all available funds on the original purchases and hang
onto them as long as possible. Those three items are my display screen, my
keyboard, and my mouse.

This trio involves the components you interface directly with all day, every
day, usually for long periods of time. For efficiency and sanity’s sake, you
should insist that these pieces of equipment be only the very best available,
and don’t change them capriciously. I liked the IBM keyboard that came with
my IBM PS/2 in 1987 so much that [ am still using it about two decades later
(even on my Macintosh, thanks to a keyboard/video/monitor switch). My
ball-less, cordless, infrared wireless mouse has been serving me well for sev-
eral years, and I only recently replaced my beloved 19-inch CRT monitor
with an almost-identical model. I look at or touch these components all day,
every day, a